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[bookmark: _Toc411419090][bookmark: _Toc487711452]Introduction	Comment by Kevin Hsu: Throughout the manual

Calling most of the menus on the 750 an option
Cut down on using “you/your”, mostly “your specimen” to “the specimen”
When referring to an option, capitalized and no quotations
DataViewer and Model Builder
Replaced square/scan button with scan button


*Reminder to update Table of Contents when all  edits are finished	Comment by Miguel Gonzalez: nice
The F-750 Produce Quality Meter aids agricultural suppliers in developing a fruit maturity and sweetness management process for the benefit of growers, processors, and consumers. Judging fruit maturity by shape and color alone results in varying success. The F-750 delivers the stability, repeatability, and precision that is necessary for successful chemometric-based measurements without destroying the product in a portable easy-to-use device. It comes equipped with a GPS for spatial mapping, enabling users to generate orchard-wide maps of fruit parameters. With this information, users can plan harvest sequences and improve crop management techniques. The F-750 uses Herschel-infrared or NIR-a spectroscopy to estimate a variety of important produce quality indicators such as dry matter, Brix (total soluble solids), or acid content.
 “For quantitative analysis of complex samples, fast and inexpensive spectroscopic methods are preferable to the slow, expensive, and destructive ‘wet chemical’ approach. Historically, one disadvantage of spectroscopic methods has been the difficulty of determining frequency regions where the constituent of interest selectively interacts with light. Now with the power of multivariate techniques such as Partial Least Squares, we can use the spectra (X) to predict the concentration of the constituent of interest (Y), with accuracy approaching that of wet chemistry.” 
Adapted from Sjostrom and Wold (1983). A multivariate calibration problem in analytical chemistry solved by partial least-square models in latent variables. Analytica Chimica Acta, (150) 61-70. 
The principles of operation of the F-750 Produce Quality Meter allow it to predict ripeness indicators such as dry matter, soluble sugar content, degrees of brix, and many more.  Dry Matter (DM) is the ratio of the water content to the dry weight of the fruit. Dry matter is an indicator of both taste and texture in certain fruits. High dry matter fruits have sweeter tastes, stronger flavors, higher acidity, and are richer in Vitamin C. Fruit continue to accumulate dry matter until harvested. Once harvested, the DM of the fruit and the upper potential for soluble sugars the fruit will develop is fixed. The soluble sugar content (SSC) of a fruit and the degrees of brix (°brix) are interchangeable units for estimation of sugar concentration. 
In order toTo generate an NIR prediction model, a calibration or training set must be creating by collecting the spectra of a large range of samples of the fruit of interest using the F-750, then using traditional destructive techniques to directly assess the parameters of interest (i.e. dry matter, brix, etc). A prediction model is then built by loading the spectra and reference data into the provided F-750 Model Builder Software.  From this point forward, the F-750 can be equipped with the resulting model and be used to scan single fruits, and will display the values predicted by the model on the screen. The user can use this information from the device to determine readiness for harvest, sale, or consumption inexpensively and in seconds.
[bookmark: _Toc487711453] F-750 Produce Quality Meter 	Comment by Miguel Gonzalez: Too late to change. Next version
[bookmark: _Toc456601930][bookmark: _Toc456606100][bookmark: _Toc456607434][bookmark: _Toc465418564][bookmark: _Toc478567120][bookmark: _Toc487711454][image: 750-front]	Comment by Kevin Hsu: Weird background
[bookmark: _Toc411419092]

[bookmark: _Toc487711455]Features

· Portable, lightweight and easy to operate.
-One button operation for recording new measurements

· Repeatable, precise, and non-destructive measurements.
-Spectrometer standard deviation > 0.017%

· True sunlight readable transflective display.
-Contrast of this display actually increases under brighter sunlight

· Removable, re-chargeable standard sized batteries.
- Two sets of batteries included 
- Stand-alone battery charger included
- Additional button-top 19670 (or protected 18650) batteries can be purchased from a preferred battery vendor

· 48 channel GPS 
-Allows spatial mapping of collected data 






[bookmark: _Toc411419093][bookmark: _Toc487711456]Specifications

	Spectrometer
	ZEISS MMS1 VIS-NIR

	Wavelength Range
	310285 – 11200 nm (+/- 10 nm)	Comment by Kevin Hsu: On the Test and Calibration Protocol sheet it says Nominal spectral range is 310-1100 nm	Comment by Miguel Gonzalez: When spectra is exported, those are the pixels shown. Actual wavelengths vary with spectrometer

	Spectral Sampling
	3 nm

	Spectral Resolution
	8-13 nm

	Accuracy
	Expected: +/- 0.5oBrix RMSEP (root mean square error of prediction)

	Battery Life
	1600 scans (Variable)

	PC Interface
	USB and SD card (16 GB WiFi)

	Data Recorded with 
Each Measurement
	Raw Data
Reflectance
Absorbance
Second & First Derivatives
Second Derivative Absorbance

	Temperature Range
	0-50OC

	Weight
	1.05 kg

	Dimensions
	7.1 x 4.75 x 1.75 inches ( 18 x 12 x 4. 5 cm )

	Power Source
	Removable 3100 Milliamp hour lithium-ion battery

	Light Source
	Xenon Tungsten Lamp






[bookmark: _Toc411419094][bookmark: _Ref425173571][bookmark: _Ref425173592][bookmark: _Ref425173612]

[bookmark: _Toc487711457]Theory of Operation
In order to generate an NIR model, create a training set using the F-750 to record 2nd derivative absorbance data. In order to make a strong model, training set samples must consist of the entire range of fruit development for the internal fruit quality parameter to be analyzed. Other sources of variability should also be considered when selecting training set samples and should include samples with any parameters that could affect spectral response.   Next, using these same specimens, a property of interest (reference value) is collected from the scan location on the specimen. Typical specimens include produce such as apples, mangos, or grapes, and a variety of parameters can be measured such as brix or dry matter. 
The Training Set and Reference Values gathered are loaded into the supplied F-750 Model Builder Software which identifies correlations between the Reference Values and 2nd derivative absorbance spectra from the Training Set. This is accomplished using non-linear iterative partial least squares (NIPALS) regression. The result is a prediction model which can be loaded onto the F-750 device and used to measure the parameters used to build the model.
With a model loaded on the F-750 device, the user places a specimen on top of the scanner and presses the scan button to record a new measurement. 


[image: ]Figure 1: Interactance optical design; light rays illuminate an anulus on the sample. The light then interacts with the sample by internally scattering through the tissue. Light that undergoes remission normal to the collimating lens is collected and focused onto the fiber. 

While recording a new measurement, the device…
a. Normalizes the spectrometer output using a reference shutter.
b. Records darks scans to account for dark current and ambient light.
c. Calculates diffuse reflectance by subtracting the light reflected from the reference shutter from the light reemitted by the subject.
d. Calculates reciprocal absorbance: Log(1/Reflectance).
e. Calculates first and second derivative spectra by applying Savitzky-Golay coefficients.
The second derivative spectra is then processed by the prediction model, each wavelength is multiplied by the regression coefficient, and all of the wavelengths are added up. A final intercept coefficient is added, resulting in the predicted value which the F-750 displays on screen, and saves to the instrument’s SD card along with other information such as GPS location, battery status, and temperature.	Comment by Leonard Felix: ?
Recorded battery status probably isn’t crucial information for the use	Comment by Miguel Gonzalez: It can be useful information for some users. They can calculate how much work they can get done with fully charged batteries

[bookmark: _Toc411419095]

[bookmark: _Toc487711458]Operating Instructions
[bookmark: _Toc411419096][bookmark: _Toc487711459]Unpacking the F-750
The F-750 will arrive in a carrying case with removable, rechargeable batteries, two battery chargers (one for the wall and a car charger), a white Teflon calibration disc for standard or diagnostic scans, and a clip to attach the F-750 to a belt. In addition, an SD card is included along with a hand strap. There is a tripod mount located on the bottom of the F-750 Produce Quality Meter case. Also included is a USB cable which is used to update the firmware on the device and a coring tool pictured below, which will aid in removing sample tissue from a specimen for both Model Building and Validation testing.	Comment by Kevin Hsu: Hand strap and SD card?	Comment by Miguel Gonzalez: Yup, added
[image: ].

[bookmark: _Toc411419097][bookmark: _Toc487711460]Loading the Battery
The F-750 uses 18650 Li-ion 3.7V 3100mAh rechargeable batteries. The batteries must be removed from the F-750 to be charged. To remove the batteries, twist the battery compartment cap, located on the bottom of the device under the rubber bumper. The cap can be twisted with fingers or a screwdriver to tighten or loosen. Use caution when removing batteries, as the cap is spring loaded. Both batteries should be inserted into the unit positive (+) side first (towards lens side).

Warning: Do not drop batteries, this may cause them to crack and rupture. 



[bookmark: _Toc411419098]Top View:
[image: ]






Front View:
[bookmark: _Toc456601937][bookmark: _Toc456606107][bookmark: _Toc456607441][bookmark: _Toc465418571][bookmark: _Toc478567127][bookmark: _Toc487711461] Scan Button
Power Button
 Directional Keys



[bookmark: _Toc487711462]Basic Operation
The rubber bumpers on the top and bottom should always be installed when using the instrument as they prevent the device from water damage. If the lens becomes dirty, it can be cleaned with a soft cloth. The lens is made of extremely durable Gorilla Glass and should not become scratched with normal use.  The strap should be tightened so that the device has a snug and secure fit around the hand. 
To take a measurement, power on the F-750 Produce Quality Meter. The current model will be displayed. To change the model refer to the Select Model section of the manual. Place the sample on the lens so that it makes contact with the perimeter of the bracket around the lens. Press the scan button to record a new measurement. 
During the measurement, the instrument will switch to the scan display, then collect and process the data. As the measurement is being collected ‘processing…’ will be visible on the display, a progress bar will appear at the bottom of the screen. It is very important to kKeep the sample in place until the progress bar‘processing…’ cue disappears and the measurement is complete. 
The measurement is being collected as the 1st block is displayed. The 2nd block is for processing data, and the 3rd block is for saving the measurement. A final screen will indicate that the data has been saved to the SD card before displaying the record to be reviewed.
The data is stored to a removable SD card. To remove, press SD card into the unit and it will eject. To replace, insert metal side first with the label facing the back of the unit.
If the instrument locks up or requires a hard shut-off for any other reason, hold down the power button for 10 seconds. This will force the F-750 power to turn off. Then, the instrument can be restarted.
When the F-750 device is powered on, it will make a single beeping sound if it is working smoothly. If not, the device will issue more than one beep. The number of beeps can be used to diagnose several errors that the instrument is able to detect during start-up. The following table outlines the number of beeps and the associated errors. Please contact support@felixinstruments.com if you are unable to bypass an error.  
	Number of Beeps
	Error

	2
	Device in bootloader assist mode

	3
	Battery low

	5
	Settings corrupt

	6
	Model missing

	7
	Spectrometer error

	8
	Lamp error

	9
	Shutter error

	10
	Keystroke error

	13
	Graphics error

	15
	SD card error

	16
	Unhandled error

	20
	Unknown board layout/version

	30
	RAM (memory) error


[bookmark: _Toc411419099]


[bookmark: _Toc487711463]Navigating Menus
Use the power button to turn on the F-750. After the instrument powers on, the display will show the current model loaded on the unit and the battery life at the top of the display. Instructions in the middle of the display indicate to press the scan button to record a new measurement or press the right arrow to access the main menu. 
Once at the Main Menu, the left arrow can be used to go back or exit to the previous screen. The Main Menu consists of three options: Select Model, Browse Records, or Setup Instrument.
	Menu Navigation Controls

	Key 
	Function

	Right Arrow
	Enter/engage

	Left Arrow
	Exit/go back/erase

	Up or Down Arrow
	Scroll to select option

	Hold Directional Arrow	Comment by Leonard Felix: Added. Need better description?	Comment by Miguel Gonzalez: Seems ok
	Fast scroll to select number/letter and to scroll through measurements

	Power Button
	Power on/off

	Scan Button
	Record a Measurement


[bookmark: _Ref386023569][bookmark: _Toc411419100]


[bookmark: _Toc487711464]Menu Map

[image: ][image: ]
	Comment by Miguel Gonzalez: Check whether it prints incorrectly. Remember that pages will be binded together. 
[bookmark: _Toc487711465]Select Model
The device will come pre-loaded with demo models, . uUse the up/down arrows to highlight the desired selection. To make modifications to the model, press the right arrow when the model is highlighted to get to the model sub-menu. 
These demo models can be downloaded from www.FelixInstruments.com, and will include a text file description of the model, the date the model was built, and the varieties used to build the model.
Load Model: When the right arrow is pressed while this is highlighted, the current model will be loaded, and the screen will return to the beginning display.
   -Collect Measurement: If the sub-menu of a model that is already loaded is entered, the first option will be Collect Measurement, rather than Load Model. Pressing on the right key with this highlighted will collect a measurement, similarly if the Scan button is pressed. 
Measurements Per Specimen: This option allows the user to set how many consecutive scans the device takes automatically after the scan button is pressed. 
Delay Between Measurements: If the measurements per specimen is more than one, the Delay Between Measurements option allows the user to set a pause of however many seconds desired in between the consecutive scans. The pause allows time for the device to cool off in between scans or may be used by the user to interrupt the consecutive scans by pressing any of the arrows and then pressing the left arrow to return to the Main Menu.
Scans to Average: This option allows the user to select the number of scans (measurements) that are averaged together before a value is shown on the display. 
Advanced Options: Several options can be accessed using the model sub-menu, such as the Integration Time, Intercept Coefficients, Lamp Off Shutter Open, and Lamp Off Shutter Closed. The Auto Integration Time option allows the user to switch between auto integration time and manual integration time. When it is disabled, the integration time values can be set manually. Only when the Auto Integration Time is disabled are the options to adjust the integration time turning the lamp on and off will appear. 	Comment by Leonard Felix: Explaination?	Comment by Miguel Gonzalez: Since they are advanced options, it isn’t bad to assume the user knows what they mean
Using the Intercept Coefficient 1 and Intercept Coefficient 2 options, a new value to use for the intercept coefficient can be entered. The intercept coefficient is from the regression vector. 
Press the left arrow to get back to the model sub-menu. If the left arrow is erasing characters on the display, keep pressing the left arrow to erase all the characters and then it will exit to the previous menu. 
[bookmark: _Toc411419101][bookmark: _Toc487711466]Browse Measurements
Once a measurement is taken, it will be saved onto the SD card and may be accessed by pressing the right arrow with Browse Measurements highlighted. Use the up/down arrows to highlight the desired measurement. Once it is highlighted, press the right arrow to access the measurement data. Each measurement has different parameters saved in it, depending on the model used when taking the measurement. For example, a mango model may include values for dry matter, color, and chlorophyll. 	Comment by Leonard Felix: Timestamp, Filename, Location?	Comment by Miguel Gonzalez: It is best to say parameters since when creating a Model these parameters can be changed
Press the right arrow while on the measurement data screen to enter the file menu. 	Comment by Leonard Felix: File menu? 	Comment by Miguel Gonzalez: The name doesn’t seem too bad if you think about it. It is a menu to manipulate the file in some way like in Windows or OS X 
Change Lot #:  This option allows the lot number of the measurement to be changed.	Comment by Leonard Felix: Check wording
Change Sample #: This option allows the sample number of the measurement to be changed.
Delete Measurement: This option is used to remove a record permanently.
Rename Measurement:  This option is used to change the filename of the measurement. 
Measurement Details: This menu provides information like the model used to collect the measurement, timestamp, file size, collection details, and location of the scan.  
[bookmark: _Toc411419102][bookmark: _Toc487711467]Setup Instrument
The Setup Instrument menu houses the features and settings that are adjustable by the user. 
Lot & Sample #:  The lot and sample numbers are used to help organize data so that the groups from which samples are taken from may be recorded. For example, if multiple boxes of apples had to be scanned, the lot number would be assigned to each box and the sample number would be assigned to each apple in a box. The lot and sample numbers are included in the filename of a measurement and increment with each scan. 	Comment by Leonard Felix: ?	Comment by Miguel Gonzalez: Makes sense. A lot # can also be a row in a crop field, etc.
   -Current Sample #: This option is used to change the sample number for the next scan. Enable the Append as Measurement function to apply this logic.
   -Current Lot #: This option is used to change the sample lot number for the next scan.
   -Increment/Decrement Logic: This accesses a submenu to set auto-numbering options. Within this submenu, the “Decrement if Measurement Deleted” is a simple Enable/Disable option which is used to automatically decrease the sample number by one if the previous measurement is deleted. The “Increment Lot # Every X Samples” option is used to set the number of scans before the label number is increased by 1 and the scan number is reset to 1.  This option can be used to auto-populate labels for a sample set in which multiple scans will be taken for each sample.
-Append as Measurement: This option enables a lot and sample number system that can be modified by the “increment” logic in the previous option. If this option is disabled, the first scan taken will be assigned the number 1 and increment for each subsequent scan. Enabling this option allows the user to automatically populate the labels for a sample set where multiple scans will be taken per sample.
Measurement Record Prefix: A prefix is the label placed on each measurement along with the lot and sample number that may help with organizing data. Within the Measurement Prefix option, a new prefix can be entered or a recently used prefix can be selected. The New Prefix option allows the user to choose a new prefix. The prefix has a maximum of 16 characters. The Select A Recently Used Prefix option will generate a list of recently used prefixes. Use the up/down arrows to highlight the desired prefix to be used, and the right arrow to select the desired prefix.	Comment by Kevin Hsu: Confirm with Brien	Comment by Miguel Gonzalez: Please remember to ask him if I forget
Archive Measurements: The Archive Measurements menu will store all data currently in the populating the list of measurements into an archive folder on the SD card. The data in the archive folder may now only be accessed through DataViewer. The Create Folder option will make a new archive folder with the timestamp as a default name. The name may be changed and upon confirming the name by pressing the right arrow at the end of the name, all data in the browse measurement menu will be transferred to the folder. The Select Folder option allows all data in the browse measurement menu to be transferred into a previously created archive folder by moving the cursor with the up and down arrow and pressing the right arrow when the cursor is highlighting the desired archive folder.
Date & Time: The Date & Time option allows the timestamp on the F-750 to be adjusted. 
Training Sets: Creating a training set is the first step in creating a model. This menu is used when collecting spectra to use in the training set.
   -Create New Training Set: First, enter the name to use for this new training set. Next, enter the number of specimens that will be used to build this model. The minimum number of specimens required is 10 and the maximum number allowed is 5,000. 
Once a new training set is created the options are Browse Specimen Data and Delete Training Set. If the Browse Specimen Data option is chosen the user is prompted to choose from a temperature range (minimum, mid, and maximum). At each temperature, there is a numbered list of the specimens. Highlight a specimen by using the up/down arrows. When Specimen 1 is highlighted, press the right arrow to collect data for the training set. The instrument will indicate “Processing” and then “Creating Training Set”. Once it has completed, do not press the scan button to gather training set spectra. The scan button only initiates a measurement. The space next to Specimen #1 will change from (empty) to (timestamp). Repeat with each of the 20 specimens at each of the 3 temperatures. Specimens can be re-done if a mistake is made or the wrong specimen/temperature is selected. 
   -Modify Existing Training Set: This menu produces a list of training sets on instrument. Press the right arrow on a desired training set edit, or delete a training set.
GPS Receiver: The GPS receiver menu shows the state of the GPS sensor as enabled or disabled. If the GPS sensor is enabled, View Status will appear with the following parameters: latitude, longitude, satellites in view, whether there is a satellite lock or not, and Horizontal Dilution of Precision (HDoP). When taking a GPS reading, be sure to keep the unit upright and the top of the instrument free from obstruction. If precision is required for measurement, an HDoP reading of 1-5 is recommended.
Keypad Sounds: This option allows the noises the instrument makes when the arrow are pressed to be changed. There are four options: Disabled, in which the device will make no sound when a key is pressed, and then Quiet, Default, and Loud.
Notification Sounds: This option enables an amplified speaker and beeper to audibly verify when a scan has completed.
Language: At this time the F-750 supports English only, but the firmware update installs a language pack that can allow and recognize different language characters.
Diagnostics: This menu is intended for debugging and support. Within the Diagnostics>Manual Test menu, the following options are available: Scans to Average, Integration Time, Lamp State, Shutter State, Number of Repetitions, Delay Between Repetitions, Measure Spectrometer Noise, and Collect Spectra.
   -Scans to Average: This option allows the user to select the number of scans (measurements) that are averaged together before a value is shown on the display. The integration time for the calibration-collect spectra can also be set. 
   -Lamp state: This option is used to turn the lamp on or lamp off. Press the down or up arrows to turn the lamp off or on. The shutter state works similar to the lamp state. The options are shutter closed or shutter open (press down/up to open/close shutter). 
   -Collect spectra: This option will use whatever values are set in the diagnostics menu to collect spectra. After rendering, the results will be saved to the SD card in .raw format. This data can be analyzed by inserting the SD card into a computer and extracting the data. 
- Advanced Setup: If the advanced setup menu is selected, a warning will appear that calibration should only be performed by authorized users. Press right to continue. Press left to abort. Instruments should only be calibrated under direction of a Felix Instruments technician. The options in this menu allow the instrument to be specifically calibrated for optimum performance. Many of these values are instrument specific such as pixel coefficients and reference voltage. The pixel coefficients are the spectrometer calibration values given by manufacturer (C0, C1, C2, C3). The pixel coefficients influence what wavelengths of light the spectrometer is responding too. 
   -Spectrometer Zero and Span: This option is used in conjunction with the white Teflon calibration standard. After the instrument has been placed in a cold environment for at least 30 minutes, place the white Teflon calibration standard over the lens and press the right arrow to take a scan. The display will flash “Saving…” and exit to the menu when the zero offset is complete. 
In addition to spectrometer settings, lamp, shutter, temperature, and auto integration time settings can also be fine-tuned under their corresponding menus. 
Factory reset: This option will erase the temporary cache files for the display screens and return to the default parameters from the manufacturer. 
[bookmark: _Toc411419103]

[bookmark: _Toc487711468]Warnings
· Do not drop! Dropping the instrument while it is turned on could cause the lamp bulb to break.
· Instrument will become warm with use, due to the lamp turning on.
· Do not drop F-750 batteries on hard surface, such as cement floor. 
· Do not leave the lamp on for more than 30 seconds. If the lamp remains on, power off the instrument or remove the batteries. 

[bookmark: _Toc411419104]Dropping the batteries on a hard surface may cause them to crack the seal and rupture. The electrolyte in the battery will slowly leak out; the electrolyte is toxic and may cause burns.

[bookmark: _Toc487711469]F-750 Data 
Data collected by the F-750 can be reviewed on the instrument by using the Browse Measurements option. The data is stored on the removable SD card. To remove, press the SD card into the unit and it will eject. To replace, insert metal side first with the label facing the back of the unit. It is best to eject and insert the SD card when the instrument is off to prevent file system errors on the SD card. 	Comment by Leonard Felix: Should we instruct user to eject and insert SD card with the device turned off?	Comment by Miguel Gonzalez: Seems like a good idea
In order to view the files on a computer, the F-750 Data Viewer software should be installed. This software can be found on the Felix Instruments webpage located at:
http://felixinstruments.com/support/f-750-support/software 
Individual or multiple training sets of measurement scans can be opened in the DataViewer by going to File>Open. 
[image: ]

Once a file or files have been opened in DataViewer, data can be exported to be viewed. The File>Export menu gives four different options to export: Measurements, Measurements & Details, Raw Spectra, and Interpolated Spectra. 
To export the predicted values, select Measurements and choose to open the newly created .csv file. During the export, the software will prompt for a save location and again after the export is successful to open the newly created file.
[image: ]
The Raw Spectra and Interpolated Spectra export features are mainly for use by technicians. The interpolated spectra menu will allow the spectra to be accessed.  
The Archive feature will extract all possible data from the selected files and save as CSV.  
After exporting, the .csv file can be opened as a spreadsheet. This .csv can be used in other software programs. Data such as model results, which contains GPS coordinates, dry matter, TSS, battery life, and raw readings can be viewed in the .csv file. Other relevant data includes the interpolated 2nd derivative absorbance data, which contains what the model is plotting and the value at each wavelength. 
[bookmark: _Toc411419122]
[bookmark: _Toc487711470]WiFi SD Card Instructions
These instructions are meant to accompany the instructions supplied by the vendor to use specifically with Felix Instruments and a Toshiba FlashAir™ W-03 Wireless SD Memory Card.
1. Install FlashAir™ Wi-Fi card software appropriate to the SD card.
a. Visit https://www.toshiba.co.jp/p-media/english/download/wl/software02.htm to download the software for configuring the Wi-Fi card and obtain vendor operation instructions.
2. Insert the Wi-Fi card onto a personal computer (PC).
3. Open the “FlashAirTool” on your PC to configure the SD card.
4. Follow the configuration instructions prompted by the “FlashAirTool”.
5. For additional guidelines, access the “Help” menu inside the “FlashAirTool” software.
[image: ]
Optional Settings
The Wi-Fi card can be enabled in “internet pass thru mode”, outlined in the following documentation provided within the FlashAirTool software:
· Go to Network Settings on the main menu
Check Internet pass thru mode
This function is available for FlashAir™ W-03 and FlashAir™ W-02 (Ver. F19BAW3AW2.00.02 or later) cards.

When this function is enabled, the FlashAir™ card can be used like a router, by allowing another access point to be connected via the card.
When an internet access point is connected, images stored on the FlashAir™ card can be viewed, and the internet can also be accessed.
This is convenient when, for example, uploading image files downloaded form a FlashAir™ card onto social networking services, as there is no need to change the Wi-Fi device network settings on your smartphone.

[image: ]
* CAUTION: If you want to connect to the internet without using the internet pass thru mode, the wireless LAN setting connection on your smartphone or other device must be changed from the FlashAir™ card to the internet access point.
Check the “Enable internet pass thru mode” checkbox to enable “internet pass thru mode”. 
· Access Point SSID
Sets the SSID of the internet access point.
Enter the SSID for the access point that you will use. An SSID of up to 32 alphanumeric characters can be entered.
· Access Point Password
Set the internet access point password.
Enter the password for the access point that you will use.
· In your browser, enter http://flashair to view or stream your files (it has been verified it works on Chrome browser)
For more information on the Toshiba FlashAir™ W-03 Wireless SD Memory Card, contact the application vendor at https://www.toshiba.co.jp/p-media/wwsite/contact.htm,
For questions regarding Felix Instruments products, contact our support staff at support@felixinstruments.com, or by visiting https://felixinstruments.com/support/


[bookmark: _Toc487711471][bookmark: _Toc411419105]Instructions for Creating a Model 
The entire SOP for mango model building can be found in Appendix I: Mango Model Building SOP

Step 1: Creating a Training Set
Step 2: Collecting Reference Values
Step 3: Importing a Training Set and Reference Values into Model Builder
Step 4: Creating a Model
Step 5: Saving a Model to F-750
Step 6: Validating the Model

Additional Instructions: 
· Merging Training Sets in Model Builder
· Alternate Method for Training Set Creation:
Manual Data Collection and Entry
· Building a Model to Measure Two Traits
· Using the Small Fruit Adaptor 
 
[bookmark: _Toc409375904][bookmark: _Ref410304709][bookmark: _Toc411419113][bookmark: _Toc487711472]Step 1: Creating a Training Set
For training set creation, use pieces of fruit across the full range of fruit maturity. In general, the more specimens used to make the model, the more accurate it will be at predicting values. Do not include any fruit that has suffered from heat stress, sun burn, is misshapen or otherwise physically damaged. 
Influence of Temperature on Spectra: The purpose of using multiple temperatures in training set creation is to compensate for the changing molecular response to light in relation to temperature. By scanning the same fruit at 2-3 temperatures, the program is able to ignore any spectral shifts or changes that do not relate to changes in the desired trait such as fructose or starch. By including variation of temperature for the same fruit in the model, the math can autocorrect for temperature. For some applications, the need for temperature correction is small, such as in controlled storage where temperature is constant, but if the F-750 will be used on fruit which does not always remain a constant temperature, a training set will need to be created to accommodate for this potential temperature range. 
WARNING: It is recommended that if a F-750 user does not have experience model building that they build the original model at room temperature only. Temperature correction can be built into the model at a later point. This can be done by collecting additional specimen, approximately 20% of the original model-building population, and their reference values and adding these to the original model (see Appendix II). For additional information on how to perform this process see the Merging Training Sets section of the manual.
If, at any point during the training set creation process, you navigate away from the training set you are working on or turn the instrument off, you can navigate back to the training set by going to Setup menu > Training Sets > Modify Existing Training Set, then selecting the training set you wish to continue working on.

The following instructions are for creating a model at three temperatures. If building a model with just room temperature fruit, enter scans in the mid temperature menu only, leaving min and max temperature options empty.
1. [image: http://img.docstoccdn.com/thumb/orig/34837080.png]Select pieces of fruit with a wide range of maturity to be used in training set creation. 




2. [image: C:\Users\Brie\Pictures\Orchard View Cherry Pics 750\IMG_2959.JPG]Label each piece of fruit with a specimen number. 

3. [image: ]Mark the area to be scanned on each fruit. Two sides of the same fruit are often scanned depending on the variability of the fruit (sun side and shade side). If this is the case, label both sides with separate specimen numbers. 
4. Determine the three temperatures to be used for the training set (Minimum, Mid, and Maximum). It is best to choose a range of temperatures encompassing the range which the measurements will be taken, for example, 10ºC, 20ºC and 30ºC. 
5. Place the fruit in a temperature controlled area to bring the fruit to the first temperature; Minimum. 
6. After the fruit has been given enough time to come to the pre-determined temperature (generally about one hour), it is now time to begin taking measurements for the training set.
7. Turn on the F-750 and navigate to the Setup Menu > Training Sets > Create New Training Set.
8. Enter a name to use for the new training set. Press the right arrow to enter.
9. Enter the number of specimens that will be used to build this model (minimum of 10 specimens, recommended ~200 specimens). Press the right arrow again to create the training set file. Be aware this step can take a few minutes, and very large training sets (5,000 specimen) can take up to an hour to process.
10. After the training set has been created, press right to enter the Browse Specimen Data menu. Navigate to the first temperature: Minimum. Now we will begin scanning each pre-labeled specimen. Be careful not to remove too many specimens at a time from the temperature controlled environment, as you want the set temperature to remain constant across specimens.
11. Place the first specimen on the lens, and with Specimen 1 highlighted on the list, press the right arrow to collect the training spectra. Do not press the square/scan button to gather training set spectra. The instrument will indicate “Processing”.  Do not move the specimen until the “Processing” cue disappears. Do not press the square/scan button to gather training set spectra. Mark the position and orientation with permanent marker on the fruit so that measurements at the next two temperature ranges will be consistent.

12. After each specimen has been scanned, you will see a date and time included in the specimen file name. This is how you know the data has been recorded. Specimens can be re-recorded if a mistake is made or the wrong specimen/temperature is selected. 
13. Repeat for all specimens at minimum temperature.
14. After all specimens have been recorded at minimum temperature, place the specimens back in the temperature controlled area to bring the fruit to the next selected temperature; Mid Temperature.
15. After the specimens have reached the desired mid temperature, the next set of temperature data is ready to be collected. Always scan the same area of the fruit.
16. If you had turned the F-750 off while waiting for the specimen to reach their next temperature, navigate to the Setup menu > Training Sets > Modify Existing Training Set, and select the training set you created previously.
17. Within the training set file go to Browse Specimen Data and navigate to the Mid Temperature folder. Place the first specimen on the lens, and with Specimen 1 highlighted on the list, Press the right arrow to collect the training spectra. 

18. Repeat for all specimens at mid temperature. (Note: You will be using the same specimens for all three temperature sets so the specimen must be scanned in the same order each time.)
19. After all specimens have been recorded at mid temperature, place the specimens back in the temperature controlled area to bring the fruit to the last selected temperature; Maximum.
20. Wait for the specimen to reach their next temperature, then continue to next step.
21. See step 16 if you have turned the F-750 off while waiting for the specimens to reach the next temperature.
22. Within the training set file go to Browse Specimen Data and navigate to the Maximum Temperature folder. Place the first specimen on the lens, and with Specimen 1 highlighted on the list, Press right arrow to collect the training spectra. 
23. Repeat for all specimens at maximum temperature. 
24. You are now finished creating your training set. The same specimens used for training set creation will now be used to collect reference values in Step 2 “Collecting Reference Values.”
25. It is recommended to import data into F-750 Model Builder Software to verify scans are saved before destructive sampling of fruit.

[bookmark: _Toc409375905][bookmark: _Ref410304741][bookmark: _Ref410304747][bookmark: _Toc411419114][bookmark: _Toc487711473]Step 2: Collecting Reference Values
To collect Reference Values, the same fruit specimens used in training set creation will be measured. The Reference Values are those values determined by your reference method (i.e. a destructive measurement of TSS or DM). For example, if you intend to measure brix, Reference Values could be measured with a refractometer, or total acids could be measured through acid titration. Careful data management is paramount for this step, and extra care should be taken to keep specimens well organized and numbered. For the purposes of this example, we will describe the method for measuring dry matter. 
1. Using a sharp knife, remove the fruit skin from the area which was marked and scanned with the F-750 being careful to fully remove the skin ONLY and not any sample tissue under the skin. but also to remove as little meat as is possible. 
WARNING: Even removing a couple millimeters of flesh under the skin will significantly influence the data. Remove skin only. 
2. [image: ][image: ]Cut the sample into a small piece, skinless piece. An average piece would be about the size of a 2x2x2 cm cube or smaller, depending on the size of the sample, OR, use a corer: push a 26mm (representative of the area scanned) circular corer toward the center of the fruit in the prepared area. Remove the corer and slice the core close to the seed, removing the core. Trim the core on the seed side, so the total height of the cylinder is 2cm and represents the area and depth scanned on the specimen.
3. Weigh the sample immediately and record the weight to the nearest 0.001 grams. 
4. Dry the samples in a dehydrator for 48 hours set at 63-65ºC.
5. After 48 hours, re-weigh the samples and record the values. Dehydrator times and temperatures may vary for different types of fruit.
6. Using these weights, dry matter (%) can be calculated for each specimen by dividing the dried mass by the original mass. These dry matter values will be our Reference Values corresponding to the measurements taken in the creation of our training set.

[bookmark: _Toc409375906][bookmark: _Ref410304756][bookmark: _Toc411419115][bookmark: _Toc487711474]Step 3: Importing a Training Set and Reference Values into Model Builder
After both training set data and Reference Values have been collected, we now have the necessary data to build a model. It is important to save your Model Builder file so that you can return to it at a later time and add additional data if desired. 
1. Open the F-750 Model Builder Software program. If you have not already downloaded this program onto your computer, please download at: https://felixinstruments.com/support/F-750/software/www.felixinstruments.com/F750/ModelBuilder
2. Remove the SD card from the F-750 and insert it into your computer.
3. First, we will import our training set. Which is the set of scans recorded on the F-750 as .f750ts file extensions. In Model Builder, navigate to the Import button on the right side of the software window.  
4. [image: ]You will be prompted for the location of the training set file. To select the desired training set, navigate to the SD card folder on your computer, click on training sets, and select the training set you created. Click “Open”.
5. You will be prompted with the message “Would you like to overwrite the existing training set?” Select Yes. If interested in adding to an existing Model Builder project, please go to the “Merging Training Sets” instructions found on page 5655.
6. When you created your training set, if any specimen files were left empty, they will automatically be excluded.
7. Model Builder will automatically populate the training set and the spectra should now be displayed on screen. Specimen number, Spectra Name (Min, Mid, Max temp), and the pixel values can be found under the Training Set tab at the bottom of the screen.
8. Use the mouse wheel to zoom in/out on the graph. Click and hold the graph to pan. 
9. [image: ]To select a single specimen in the spectra, select the row in the training set list below, or hold the control key (Ctrl) and click to choose the line in the graph above. To select all specimen rows, click the empty cell to the left of the Exclude column header. This will select all specimens imported in the training set. To exclude a specimen, click the Exclude box to the far left of each specimen row. Multiple rows can be selected by holding down the shift key for a contiguous set or the ctrl key for individual rows.


10. [image: ]Next, we will import our Reference Values, which are the values independently gathered and not by using the F-750. For example, for Brix one may use a reference method of reading Brix values on a refractometer, or titratable acids on a titrator. These results will be recorded separately on a .csv or .xlsx (excel) file. If they are saved in .csv format, click the Import button. If they are not in .csv format, they can be manually entered or copied and pasted from Excel or similar spreadsheet programs as a column with no header. Specimen numbers are auto-populated starting at 1.  
 

11. Be sure that all specimens included in the training set also have corresponding and matching Reference Values. To change the column headers, double-click to rename them (e.g. Dry Matter or TSS). Model Viewer can detect if there are missing or multiple specimens.  
[bookmark: _Toc409375907][bookmark: _Ref410304769][bookmark: _Ref410304779][bookmark: _Toc411419116][bookmark: _Toc487711475]Step 4: Creating a Model
Now that we have both our training set data and our Reference Values imported into Model Builder, we are ready to build or create the model. Model Builder illustrates spectra quality (noise). It is recommended that the user manually selects regions to include by choosing a spectra range, such as 729-975 nm. 
1. Model Spectra Window Selection 
a. [image: ]Generally, it is best to manually select a spectra range based on the known range of a particular fruit or constituent being measured. For example, choosing a range of 729-975 nm for sugar or starch. For additional ranges, see the “Supporting Science” section at the end of this manual. To manually select a spectral region, enter the desired range under the Model Spectra tab located at the bottom of the window.
[image: ]

b. Seeing a neatly layered rainbow effect with the colors (green-orange-red) in the selected range is optimal and indicates agreement of spectra and known results.  
2. When all data are entered and modifications made, build the model by clicking the Build button in the toolbar near the top of the window. The application will indicate that the model has been successfully built and a new tab will appear at the bottom of the screen: Model Performance Analysis.

Model Performance Analysis
The Model Performance tab allows for the interpretation and optimization of the underlying mathematical regression used by the F-750. The various graphs in the drop down menu allow for analysis of different aspects of the multivariate data, including principle components (explained variance), root mean square error (RMSE), model linearity, prediction error, regression coefficients, error/deviation ratio, and scores plot. Analysis of regression coefficients and prediction error will indicate the fit of the model.
The two major concerns when inspecting a model’s results for how the regression fits are: number of principle components and outliers. The optimum number of principle components to include will be selected by the program, but alternate numbers of principle components can also be selected to optimize data fitting. By selecting too few principle components there will not be enough representation, too many components and the correlation could be a coincidence because noise is included. 
The prediction error graph is often the most useful; the closer the Reference Value is to the prediction, the lower the prediction error and the more accurate the model. 

Using the Model Performance Analysis Tab:
The following outlines each screen or graph seen on the model performance analysis tab as an interactive walkthrough using the Grape Demo model that is included with the F-750 device.  
After the model is successfully built, the F-750 Model Builder Software will show the Model Performance Analysis tab.  Click on the tab and the first screen shown is the explained variance. 
[image: ]The explained variance graph is useful for understanding how well the variation in the known value is spanned by the regression model. As the explained variance increases, the model is better incorporating the entire data set. The information is displayed in a line graph to show the contribution from each principle component (PC). Overfitting can occur if principle components are included in the model that do not incorporate more of the dataset. 

Navigate to the next graph in the drop down list, root mean square error (RMSE). The blue line indicates the root mean square error calibration (RMSEC), which represents the average error of the complete regression. The red line indicates the root mean square error of cross validation (RMSECV). This is the average error of a simulated independent data, either with full or leave-one-out cross validation. 
[image: ]RMSECV is the average error and is considered to be the error within the first standard deviation or 68% of all readings. The F-750 Model Builder Software determines the optimum number of principle components by looking for a minimum decrease of at least 5%. In the example below, 8 principle components have an RMSECV of 0.61, a 5% decrease in error would be 0.58. Because 9 principle components have an error of 0.59, Model Builder has determined that 9 and above principle components are an over fit.

[image: ]The following graph in the model performance analysis tab is model linearity. Model linearity represents the goodness of fit of the regression. A model with an R2 less than 0.7 will likely not meet performance expectations.

[image: ]The Prediction Error graph displays the reference value vs. the predicted value for both the complete regression and the cross validation. This graph is useful for determining outliers or specimen that do not fit well within the regression. 

It is helpful to go back to the “Training Set” tab and exclude samples to see how it influences RMSECV and the prediction error graph.

[image: ]After the prediction error is the Regression Coefficients graph. The regression coefficient values are applied in a dot product with spectra to determine the predicted value. 

[image: ]Navigate to the Scores Plot graph, which is used to identify clusters or groupings in data. In the example below, the red table grapes form a small cluster below the green grapes. The figure below has a red and green circle indicating the red and green grape clusters. Additionally, spectra such as the single scan in the lower right quadrant may be considered a potential outlier as it is far from other points. 

[image: ]The Wavelength Influence graph shows how much each individual regression coefficient is contributing to the predicted value, essentially indicating the important pixels for prediction.  These coefficients are calculated by examining the degree of prediction linearity versus the magnitude of the spread of data at a particular wavelength in comparison to the rest of the spectra. Wavelengths with high prediction power and a large range are weighted more heavily than those where one or both of the parameters are small. These highly contributing wavelength regions are easily
[image: ]


Model Fit Parameter
Use: The Model Fit Parameter is a numerical indicator of usefulness of the current model. This number is located on the sample scan screen below the model name on the upper right corner of the screen. Numbers larger than 0 indicate that the sample does not fit well into the currently selected model, and thus the predicted variables should be viewed with skepticism. Variable prediction improves the closer this number gets to 0. Future firmware versions will include software to automatically select the best model for measurements. Users may determine usefulness of the model fit parameter by loading sample spectra into the training set Model Builder file to determine where and to what degree the spectra deviates from the training set. 

Calculation: The Model Fit Parameter is calculated based on the deviation of spectra signal from the training set range.  When recording training set measurements, the F-750 internally tracks the high and low signal extremes for each wavelength. Upon taking a sample scan using these training sets, any point at which a sample spectrum deviates from the training set range triggers an addition to the model fit number. This addition is weighted based on the “wavelength influence” regression coefficient multiplied by the degree of deviation from the established range. Thus, a sample scan that fits perfectly within the training set range will yield a model fit number equal to 0, while subsequent deviations will scale according to the wavelength influence and magnitude of deviation. See Fig 1 & 2 below.

Fig.1 & 2



Optimizing the Grape Demo Model:
[image: ]Now we will go back and optimize the grape demo model.  To begin, navigate back to the Scores Plot and hover over the Potential Outlier scan in the lower right quadrant. We can see that this is specimen number 239 with the spectra name of r39. This stands for the 39th red grape scanned in the training set. 

[image: ]To investigate if this specimen is an outlier, we need to go back to the training set tab and locate specimen 239. Next, check the Exclude box next to #239.  

Now that Specimen 239 is excluded, we can re-compute the model by pressing the Build icon. Then, explore the impact of removing specimen 239 from the training set. Because the RMSE and Model Linearity graphs show no change, it can be concluded that specimen 239 is not an outlier and should be included in the training set. Go back to the training set, include #239 and build the model again.
[image: ]Next, look at the Prediction Error graph. Here, you can see that specimen 260 is poorly predicted by the model. Repeating the steps above, Exclude specimen 260 and explore any changes to model performance in the RMSE and model linearity graphs.

After excluding specimen 260 and re-building the model, a decreased RMSE and slightly increased R2 value is seen. This indicates that specimen 260 is likely an outlier or at the very least a poor fit for the model.  
It is important to note that outlier removal must be done delicately and for sufficient reasons. It is inappropriate to simply remove specimen until you have a “perfect model.” Outliers can result from internal defects, human error in reference method, or insufficient sampling of real variance in fruit population.

Additional Information from Scores Plot:
[image: ]The following shows the effect of temperature on the O-H peak (spectra) of a cherry. The upper curve in pink is room temperature and the lower blue curve is cold storage (min temp). Temperature alters the photoactive response of certain common chemicals, like fructose or starch and this can be seen in the gathered spectra.  
[image: ]



[bookmark: _Toc409375908][bookmark: _Ref410304791][bookmark: _Toc411419117][bookmark: _Toc487711476]Step 5: Saving a Model to F-750
1. To save the model, go to File > Save as. In the ‘Save as type’ drop down box, ensure that you save the model that corresponds to your F-750 firmware. Select a location to save the file on your computer. Now that the model is saved, you can return to it at a later time to add additional values or edit the model.
[image: ]
2. To save the model to an F-750 SD card, locate the SD card and save your new model (verify that your ‘save as type’ corresponds to your F-750 firmware version) in the Models folder. 
3. Insert the SD card back into the F-750. Your new model is now ready to use!
[bookmark: _Toc409375909][bookmark: _Ref410304805][bookmark: _Ref410304813][bookmark: _Toc411419118][bookmark: _Toc487711477]Step 6: Validating the Model 
After a new model has been created and loaded onto the F-750, it is important to validate that the model is working correctly. To do this, there are a number of different methods available. One of the simplest methods for on device validation is as follows:
1. Start the F-750 instrument.
2. Go to Models > select the model just saved to the device.
3. Press the right arrow and then select Set As Current Model.
4. Place a specimen on top of the F-750 and press the scan button.
5. Scan several specimens and measure to gauge the variance of the model. 
6. You can then use your selected reference method (used to calculate Reference Values) to verify that these values are accurate.
On Device Validation: 7 Days Turnaround 
This procedure allows for creating and validating a model for dry matter, titratable acid, or other reference values with a lengthy process. This procedure is specific for dry matter.
· Day 1: Training Set scans, prepare and weigh samples, load dehydrator
· Day 2: Dry (wait time)
· Day 3: Finish drying, final weigh and calculate dry matter. Build and optimize model in F-750 Model Builder Software.
· Day 4: Load model onto F-750 device, take scans of validation fruit. Prepare and weigh samples, load dehydrator
· Day 5-6: Dry (wait time)
· Day 7: Finish drying, final weigh and calculate dry matter. Check predicted value vs. known value on device.
The procedure for Brix is shorter, with day 1 consisting of the training set, reference values and creating the model.  Day 2 consists of on device prediction and reference values. 
Notes: 
· The model’s margin of error is based on the training set, quality of reference method, and if the region selected in the training set has a correlation. 
· Specimens above or below the range of Reference Values used to create the model will not predict accurately. This is why it is so important to select a wide range of fruit at various stages of maturity when you are creating the initial training set. 
· Model performance reflects how well the training set represents prediction subjects. 
[bookmark: _Toc487711478][bookmark: _Toc409375910][bookmark: _Ref410304833][bookmark: _Ref410304869][bookmark: _Toc411419119]Customizing Device View
Device view allows options for the user of the F-750 to manipulate the data displayed on the screen of the F-750 during measurement. The Device View tab will become available for manipulation after a model is built. It is not recommended that a user make changes under this tab without full review of the instructions below. Contained within device view are many options for customization of on-screen elements, which is anything that is displayed on the screen of the F-750 as well as customization of calculated variables, on-screen elements that are calculations performed by the instrument. 
Model Builder automatically generates a layout for the on-device presentation of the data shown in figure 3. Variations to these on-screen elements must be made in the device view tab.
[image: ]Figure 3. Default on-screen elements and layout of the F-750 display screen as generated by Model Builder.GPS location

Fit of the current prediction
Name of the model
Measurement number

The opening layout for Device View can be seen in figure 4. 
[image: ]Figure 4. Opening layout of the Device View tab in Model Builder. 

[bookmark: _Toc486501467][bookmark: _Toc487711479]Simulated Device State
The device view tab automatically opens to display the simulated device state. This selection shows all the screen elements that are automatically available. To the right you can see a simulated view of the display screen as it will appear on the F-750. As you add and remove on-screen elements, they can be tested in the simulated device state to make sure they appear and operate correctly. Changes made under the simulated device state will not make permanent changes to the displayed elements. Changes must be made by selecting the desired element’s unique identifier under the main drop-down menu and making changes in the customizable selections, detailed below. Most of the on-screen elements are calculated variables. Table 1 lists all the options in the drop-down menu and their corresponding variable type. For descriptions and examples of each variable, please see table 3 in the Adding and Removing On-Screen Elements section. 
	Name
	Corresponding variable

	PredictionValueLabel
	n/a (this is an on-screen text element only, not a variable)

	PredictionValueVariable
	Prediction 1
Prediction 2

	RecordNumberVariable
	Measurement NumberAndCount

	ModelNameVariable
	ModelName

	ModelFitScoreVariable
	Prediction1Fit

	LotAndSampleVariable
	SampleNumberAndLotNumber

	CreatedDateVariable
	CreatedDateTime

	FilenameVariable
	FileName

	LocationVariable
	GPSLocation


Table 1. Customizable screen elements available in the main drop-down box and their corresponding variable type when applicable. 
[bookmark: _Toc486501468][bookmark: _Toc487711480]Customization of On-Screen Elements	Comment by Miguel Gonzalez [2]: Should we add a table in the beginning with all the different options available? This table can also indicate if those options are for a variable element or a text element	Comment by Jessica Oen [2]: That is the table right above this section. I can reference it in this section. I can also add an identifier to each of the elements above as ‘on-screen element’ or ‘variable’ or just label the variables as variables. 
	Comment by Miguel: I mean a table outlining the various options. Some of these are for variables only, others are for text elements

Selecting a specific on-screen element in the drop-down box will allow one to manipulate factors related to the appearance of that element. Options for customization can differ depending on if the on-screen element is a calculated variable. The options for customization for variables include name, selection of the specific variable, format, prefix, suffix, location, alignment, type, and hidden status. Any on-screen elements that are not variables will have options for name, text displayed, location, alignment, type, and hidden status. See table 1 above for the list of on-screen elements available for customization in the drop-down box. 
	Options for customizing a calculated variable:
	

	[image: ]
	

	





Options for customizing an on-screen element:

	[image: ]


Figure 5. Options available for customization of the appearance of on-screen elements, including calculated variables. 
[bookmark: _Toc486501469]Name
The name option refers solely to a unique identifier for this screen element. It does not change any text displayed on the F-750 screen itself. Each screen element is automatically generated a name; however, this can be changed for ease of understanding.
[image: ]Figure 6. Example of the customization of the name field. 
For example, Prediction1 is automatically named PredictionValueVariable. If the first trait the model is predicting is dry matter, Prediction1 could be renamed ‘DM’ for ease of understanding. 
[bookmark: _Toc486501470]Text
On-screen elements that are not calculated variables have a text box option. This is where a user specifies what the text should read.
[bookmark: _Toc486501471]Variable
Variable identifies the calculated program variable that is being run. Descriptions of each of these variables can be found in table 3 below.  
[bookmark: _Toc486501472]Format
Format indicates how the variable should be formatted. Refer to table 2 for proper formatting rules. 
	Variable Type
	Formatting Rules
	Example
	Possible Interpretation

	Number
	Dx, where x is the number of digits one wishes displayed following the decimal point
	D2
	12.34

	
	
	D3
	12.340

	Text
	Tx, where x is the maximum length
	T4
	Brix

	
	
	T5
	Mango

	Date
	y=year
M=month
d=day
h= hour 12
H= hour 24
m=minute
s=second
f=second fraction
t=A.M. or P.M.
	d/M/yyyy HH:mm:ss
	9/3/2017 16:05:07


Table 2. Formatting rules for the customizable format option of on-screen variables.
[bookmark: _Toc486501473]Prefix
Customization of the prefix refers to any text a user wants displayed before the variable. For example, a user could add ‘brix’ as a prefix to identify the corresponding screen element as the brix prediction. 
[image: ]Figure 7. Example of an addition of a prefix before prediction 1 and the screen’s simulated state on the right. 
[bookmark: _Toc486501474]Suffix
Customization of the suffix refers to any text that will be displayed after the variable. For example, a user could add ‘brix’ as a suffix to identify the corresponding screen element as the brix prediction. 
[bookmark: _Toc486501475]Location
Location identifies the coordinates where the on-screen element physically lands on the screen. Alternatively, screen elements can be physically moved around on the simulated display screen to the right and the location will be updated accordingly. 
WARNING: Screen elements cannot overlap one another or fall outside the bounds of the screen. If this occurs, it will not display properly on the F-750. 
[bookmark: _Toc486501476]Alignment
Alignment refers to whether the screen element should align to the left or to the right. Generally, screen elements you want on the left side of the screen should be left aligned while elements you want on the right-hand side should be right aligned. 
[bookmark: _Toc486501477]Type
Type refers to the size of the screen element. There are three options—small, medium, and large. 
[bookmark: _Toc486501478]Hidden
The hidden status, true or false, refers to whether the screen element will be visible on the F-750 device. 
Except for overlapping screen elements, if a customizable option is entered incorrectly or in an invalid format the simulated device screen with show a red exclamation mark. Clicking on the exclamation mark will yield details of the error. 
[image: ]
Figure 8. Example of red exclamation mark warning indicating an incorrect customization of an on-screen element.
[bookmark: _Toc486501479][bookmark: _Toc487711481]Adding and Removing On-Screen Elements
To the left of the variable drop-down box are options for adding and removing screen elements. Screen elements cannot be added or removed while under the simulated device state. 
[bookmark: _Toc486501480]Removing screen elements
To remove a screen element, simply select the desired screen element for removal in the main drop-down box and then select the ‘remove’ button. Note that there is no undo option in the software, so be sure that you do want to remove a screen element before doing so. 
[bookmark: _Toc486501481]Adding screen elements
As mentioned in the introduction, the screen generated by Model Builder defaults to a few set screen elements. If the addition of another variable is desired then the ‘Add’ button can be used to do this. 
Clicking the add button will generate five options for the type of screen element that can be added. These include static text, program variables, ratio index, rules, and macros. 
Static Text
Adding static text refers to adding an on-screen element that is solely a text box. No calculations are being performed by the instrument to generate this screen element, it is static. Adding static text allows six options for customization—name, text, location, alignment, type, and hidden status. Each of these customization options are detailed above in the ‘Customization of On-Screen Elements’ section.
[image: ]Figure 9. Example of an addition of a static text box.One must designate a location for the text on the screen. You can drag and drop the text box on the simulated device screen. 

Program Variable
Adding a program variable is the addition of a calculated on-screen element. The options for which program variables can be added can be found in the variable drop down box. Table 3 lists all the options for addition of a calculated variable and their descriptions.
	Variable
	Description
	Example

	Prediction1 
	The first trait that the model is predicting for
	15.6 (dry matter)


	Prediction2
	The second trait (if applicable) that the model is predicting for
	10.3 (brix)

	Prediction1Fit
	The fit of the first prediction (see page 48 for more details)
	0.001

	Prediction2Fit
	The fit of the second prediction
	0.021

	MeasurementNumber
	The measurement you are on as indicted by a measurement number out of total number of measurements
	1 of 100

	ModelName
	The model identifier
	Hass Avocado 

	GPS location
	The GPS coordinates of the measurement 
	46.221, -119.567

	FileName
	Name of the saved scan
	Avo12

	CreatedDateTime
	Date and time of measurement
	1/2/2017 7:12

	SampleNumberAndLotNumber
	Sample number over lot number
	1/3

	SampleNumber
	The sample you are on as indicated by a numeric value
	1

	LotNumber
	The lot you are on as indicated by a numeric value
	3

	Prediction1LotAverage
	The average of prediction 1 across a pre-defined sample number
	12.2 (dry matter)

	Prediction1LotStandardDeviation
	The standard deviation of prediction 1 across a pre-defined sample number
	1.3 (dry matter)


Table 3. Options of additional variables. 
A common example of a desired added program variable would be if an end user wants the F-750 to display both predicted traits for a two-trait model. The default display shows only one predicted value. To add a second, one would click ‘Add’ and select ‘Program Variable’. In the drop-down box across from variable, the user would select Prediction2. Move the new variable to the desired location on the screen, notice that the location changes in the customizable options. Ensure that the number of digits to be displayed are specified across from format. 
WARNING: Failure to specify the digits desired for the program variable will result in on-device screen error. 
[image: ]
Figure 10. An example of a properly customized additional variable. 
Ratio Index
Addition of a ratio index adds a calculated ratio between two wavelength values. There are options to use a customized ratio index or to use pre-programmed common ratio indices. This selection can be made across from ‘Type’. Pre-programmed indices include commonly used indices for chlorophyll absorption. If a custom ratio index is chosen then the formula for this calculation can be entered in the box across from ‘Formula’. Entries into the formula box should be formatted similar to an equation entered in an Excel cell. 
Use a wavelength prefix to denote the spectra type, where A=absorbance, FD=first derivative absorbance, SD= second derivative absorbance, and M= macro spectra. When decimal numbers are used they must be suffixed with the letter ‘f’. An example of a correctly entered formula would be ((A[699]-A[669]) – 0.2f * (A[699]/A[669]). 
[image: ]
Figure 11. Example of an addition of a custom ratio index. 
Rule
Addition of a rule will trigger the F-750 to respond in registered ways to a calculated variable. The two actions that the F-750 can be triggered to make based on a variable are to give signaling beeps or to hide selected screen elements. To set up a rule on the F-750 first select the calculated variable that you want the rule to apply to under the drop-down box across from ‘Variable’. Next, select the condition that the rule will be applied under. Options for conditions include ‘Equals’, ‘DoesNotEqual’, ‘GreaterThan’, and ‘LessThan’. Next, select the value that the condition applies to. For example, if you want the F-750 to perform a certain signal if the brix content of your commodity scanned ever falls below 9.0 degrees, you would set this up by selecting ‘LessThan’ across from condition and setting the value to 9.0. Next, you choose the signal you want the instrument to perform. Currently, there are only two options—beeping or hiding a screen element. 
Beep
If the action selected is beeping, further details can be specified. Specifically, the duration of the beep and the number of beeps. Beep duration indicates the duration of the beep in milliseconds. 
[image: ]Figure 12. Example of a correctly specified rule. If prediction 1 is less than 9, the F-750 will give a single 500 millisecond beep.
Hide Screen Element
If the action selected is to hide an on-screen element than the name of the element to hide must be entered in the box across from ‘ElementToHide’. The entered text should be in the format of the name of the on-screen element. If, for example, a user wanted the predicted value to be hidden from the screen under a certain applied rule they would enter ‘PredictionValueVariable’ as the element to hide, as this is the default name of the prediction. If a user had changed this name to ‘Brix’ then they would enter ‘Brix’ as the element to hide. 
Macro
Addition of a macro should only be done by someone experienced in programming or under the instruction of a Felix Technician. Specification of the macro should be done by clicking on the ‘…’ button across from ‘Value’. Macros should be written using standard C# syntax. More details can be found in the macro writing pop-up window. Templates for the macro can be found under templates in the pop-up window. Individuals writing a macro should begin from the ‘Blank’ template provided. Check the validity of the written macro by selecting ‘Compile’ in the macro window. If compiled successfully, save the macro by selecting ‘Save & Close’. Finally, select whether you want the result of the macro to be stored on the SD card with the rest of the measurement data by selecting ‘True’ or ‘False’ from the drop-down box across from ‘Save’. 
[bookmark: _Toc487711482]Additional Instructions:

[bookmark: _Toc487711483]Exporting Data from Model Builder
After a model has been built there are a couple options to export data from the Model Builder software. One available export feature includes navigating to file>export from the main file menu. This feature exports sample number, sample name, predictions, and spectral output from your built model. In addition, once a model has been built, each of the graphs viewable under Model Performance Analysis can have their data exported by right-clicking on the graph and choosing ‘Copy to Clipboard’. Paste this data into Excel or other third party analysis software for easy manipulation.
[bookmark: _Toc409375911][bookmark: _Ref410304910][bookmark: _Toc411419120][bookmark: _Ref422054486][bookmark: _Ref422054495][bookmark: _Ref422054514][bookmark: _Toc487711484]Merging Training Sets in Model Builder
Data can be added to an existing Model Builder file at any time to increase the accuracy of the model or increase the range of values. Once you have a pre-existing model, to add to the model you must collect more data with a new training set and Reference Values. To do this, follow the same steps outlined above in the Creating a Training Set (Step 1) and Collecting Reference Values (Step 2) instructions. We will assume for the following instructions that these data have already been collected. 
1. Open the Model Builder file you wish to edit. You should see the previous training set and Reference Values are already loaded in the program. 
2. Import the new training set you wish to include. In Model Builder, navigate to the Import button on the right side of the display. 
3. You will be prompted for the location of the training set file. To select the desired training set, navigate to the SD card folder on your computer, click on training sets, and select the training set you created. Click Open.
4. You will be prompted with the message “Would you like to overwrite the existing training set?” Select No.
5. You will be prompted with another message “Would you like to increment specimen numbers automatically?” The answer here depends on whether the training set is from the same population. See the following examples A and B:
a. If the training set #2 is of the same specimens, click “No”. Example training set #1 has only the minimum temperature scans of population 1 (n=20) and training set #2 has only the middle temperature scans of population 1. Select “No” to align the specimen numbers: min temp fruit_1 should have the same specimen number as mid temp fruit_1 because they belong to the same population. This results in 40 total scans with two scans for each specimen number. 
b. If the training set #2 is of different specimens, click “Yes”. Example training set #2 has only the minimum temperature scans of population 1 (n=20) and training set #2 has only the middle temperature scans of population 2 (n=20). Select “Yes” because the specimen from population #2 should have unique specimen numbers. The training set #1 will have specimen 1-20 and training set #2 will have specimen number 21-40.
6. Any empty records will automatically be excluded. The new training set data should now appear in the rows beneath the original training set, and all spectra should be displayed. The new training set specimen number will start where the first training set specimen numbers ended. For example, if training set #1 contains specimens 1-50, when you import training set #2, the first specimen will start at 51. 
7. Import the new set of Reference Values. You can also import data files (button scans) and training set (right arrow scans). If they are not in CSV format, they can be manually entered or copied and pasted from Excel. 
8. Be sure that the Reference Value specimen numbers match with the training set #2 specimen numbers. As with the example from step 6, if your training set #2 specimen numbers begin at 51, Reference Value specimen numbers also need to begin at 51 for training set #2 Reference Values.

[bookmark: _Toc409375912][bookmark: _Ref410304924][bookmark: _Toc411419121][bookmark: _Toc487711485]Alternate Method for Training Set Creation: Manual Data Collection and Entry
An alternate method for creating a training set is also available. This method involves taking measurements with the scan button (rather than using the training set feature), then importing the spectra from these measurements into Model Builder using copy and paste. This alternative method gives more flexibility in importing data, but extra care must be taken in data organization, and data entry into the F-750 Model Builder Software.
First we will collect the data using the manual method:
1. Follow steps from Part 1: Creating a Training Set, #1-6.
2. Turn on the F-750 and navigate to the Select Model menu. Select any model. For the purposes of this method of data collection, the model used does not make a difference in the spectra collected.
3. Change the measurement prefix name to keep the data organized. Go to Setup Instrument > Measurement Prefix > Enter New Prefix.
4. Now begin collecting data. Place the first specimen on the lens and press the scan button. 
5. Repeat for all specimens at Minimum Temperature.
6. After all specimens have been recorded at the minimum temperature, place the specimens back in the temperature controlled area to bring the fruit to the next selected temperature; Mid Temperature.
7. After specimens have reached the desired Mid Temperature, the next set of temperature data is ready to be collected. 
8. Change the measurement prefix to indicate you are now taking Mid Temperature data. Go to Setup Instrument > Measurement Prefix > Enter New Prefix.
9. Place the first specimen on the lens, and press the scan button to collect the measurement.
10. Repeat for all specimens at Mid temperature. (Note: You will be using the same specimens for all three temperature sets so the specimens must be scanned in the same order each time.)
11. After all specimens have been recorded at Mid temperature, place the specimens back in the temperature controlled area to bring the fruit to your last selected temperature; Maximum Temperature.
12. Change the measurement prefix to indicate you are now taking Maximum Temperature data. Go to Setup Instrument > Measurement Prefix > Enter New Prefix.
13. Place the first specimen on the lens, and press the scan button to collect the measurement.
14. Repeat for all specimens at Maximum temperature. 
15. You are now finished creating your training set. The same specimen used for training set creation will now be used to collect reference values.
Next, collect your Reference Values 
1. Follow steps from part 2: Collecting Reference Values (See Step 2 above). 
Next, extract the F-750 specimen spectra data using Data Viewer software and import into Model Builder.
1. Open the Data Viewer software program. This software can be found the on the Felix Instruments webpage located at: 
http://felixinstruments.com/support/f-750-support/software 
2. Remove the SD card from the F-750 and insert it into your computer. Locate the specimen measurements have taken for the training set. 
3. Choose files to open in Data Viewer.
4. [image: ]Go to the File>Export>Interpolated Spectra. Click on the menu and select 2nd Derivative. This is the spectra that we will use for our training set.

5. You will be prompted for a location to save the data. Select a location, and click save.
6. You will then be prompted with “Process complete. Would you like to open the created files?” Select yes.
7. You should now be viewing your data in an Excel worksheet. The first nine columns include the measurement prefix, time and date, model used, shutter open and closed integration time, and pixel coefficients. The remaining columns include the spectra which we will use for training set creation (285-1200 nm).
8. F-750 scans taken with the scan button can be imported into Model Builder using the Import button. The import button is located on the left-hand side above the spectra values.  Alternatively, scan details can be copied and pasted into the program. To do this, exclude the headings in row one, copy all spectra information. (Be sure you are only copying spectra data, and that you are copying the entire spectra 285-1200 nm). Then paste into ModelBuilder under the training set tab.
9. Open the F-750 Model Builder Software program. Note that under the training set tab, the spectra begins at the same pixel; 285 nm. This is where we will paste our data. 
10. [image: ]Click to select the 285 nm cell for specimen # 1 in Model builder. Be sure that it his highlighted blue as shown in the image above. Now paste the spectra information copied from Excel.
11. You should see your data automatically populated for each specimen. 
12. Enter the Specimen # and Spectra Name for each record. You can do this either by manually typing them into Model Builder, or to expedite this step for larger data sets, specimen numbers can be copied and pasted. 
13. Next, we will import our Reference Values. If they are in CSV format, navigate to the Import button on the right side of the Model Builder screen. If the reference values are not in CSV format, they can be manually entered or copied and pasted from Excel.  
14. Finally, now that training set and Reference Value data have been imported, you may proceed with model building as described in Step 4 “Creating a Model,” Step 5 “Saving a model to F-750,” and Step 6 “Validating the Model” sections of this guide.


[bookmark: _Toc487711486]Building a Model to Measure Two Traits
Building a model to measure more than one trait (such as dry matter, brix, or chlorophyll), is often a very useful and timesaving method. To do this, we will slightly alter our reference collection method to accommodate the collection of more than one parameter. To measure two traits we recommend using one of the following two methods:
1. Build one training set for one trait and another separate training set for the second desired trait. Each training set will use a different set of specimen. 
a. For example, use 100 apples in training set ‘a’ and collect dry matter reference values for these specimens. Use another 100 apples for training set ‘b’, but this time collect Brix reference values for these specimens. Combine these two training sets in Model Builder as discussed in the ‘Merging Training sets in Model Builder’ section of this user manual. 
2. On fruit which have a large enough area, two cheeks of the same specimen can be used for two different reference methods. To do this, create a training set by scanning two cheeks of each specimen. 
a. Each specimen should be scanned twice, once per side. Then, when collecting reference values, one cheek could be used to measure dry matter for example and the other cheek Brix. 	Comment by Miguel Gonzalez: Kevin, can you remove the highlighting? I couldn’t
When building a training set with two scans per piece of fruit (left cheek and right cheek), care must be taken as to how the data is arranged in F-750 Model Builder Software.  
[image: ]When put into model builder with a single training set, appropriately assign the reference values to the spectra, as shown in the following figure, where the left cheek is assigned odd number specimen scans and the right cheek is even number specimen scans.

[bookmark: _Toc487711487]Using the Small Fruit Adaptor Accessories
Small fruit adaptor accessories are included with the F-750. These accessories are designed to maximize and focus the light when measuring small fruits such as grapes or cherries. Two reflector cone sizes are provided to accommodate a variety of small fruit, 11 mm and 19 mm, and a small fruit adaptor, which has three spokes and a central ring, similar to crosshairs or a target.  
[image: ]
Fig. Clockwise from Top Left: 11 mm reflector cone, 19 mm reflector cone, small fruit adaptor.  
For very small fruit there is a limited amount of light on the fruit and the reflector cone can change the angle and provide more light. For example, a blueberry looks brighter when placed on the F-750 with proper reflector cone, and looks very dark without it.
Selecting a Small Fruit Adaptor Accessory:
It is important to be consistent when taking scans for training sets and predictions: the accessory should be used for all samples or for none. If the fruit does not fit in the reflector cone, and protocol is to use the reflector cone, pick a different fruit specimen that fits, or re-scan all fruit samples without the reflector cone.  
Ensure that fruit samples are positioned with the same orientation or presentation when scanning (straight up or not leaning against the side of the reflector cone). If fruit touches the side of reflector cone, it should touch the side of the cone for all measurements. Fruit should be centered using the guides on the small fruit adaptor. [image: ]	Comment by Kevin Hsu: Insert Picture
Some cherry varieties may be too large to use the 19 mm reflector cone, if this is the case, use only the small fruit adaptor. For cherry varieties with a diameter typically larger than 25 mm, it is best not to use a reflector cone or small fruit adaptor base. Also, extra care should be taken for these large cherries to take the reference value from the area of the fruit that is scanned by the F-750.  
Keep in mind that consistency in model building is key, either use the reflector cone for all cherries scanned, or none. 	Comment by Kevin Hsu: Insert Picture of right (in cone) and wrong (top of cone=reflectance)

[image: ]To use the reflector cones, one quick changeover must first be made to the F-750 by installing the small fruit adaptor (black ring with central circle and 3 spokes). Using a #1 Phillips head screwdriver, swap this adaptor with the plain one currently on the F-750. Be sure the beveled or grooved edge is facing upwards and that the post lines up with the post of the lens, as shown in the following figure.  










[bookmark: _Toc411419124][bookmark: _Toc373304036]After the small fruit adaptor is installed, center the small fruit specimen on the central ring. This small ring will hold the fruit specimen in the correct position for measurements to be taken. Now, place the reflector cone over the specimen. You will notice that there are magnets installed within the reflector cone to obtain a good fit.

[bookmark: _Toc487711488]Cleaning and Maintenance
Keep the lens of the F-750 clean and protected from dirt and scratches. If the lens is dirty, unscrew the cover plate and gently wipe the lens in a smooth straight motion with rubbing alcohol and a clean nonabrasive cloth. Then, re-affix the cover plate. With normal use, the durable Gorilla Glass lens should not scratch. If the lens requires rinsing with water, ensure that the rubber bumper (that protects water from leaking into the USB and SD card slot) is snugly installed. The rubber bumper and the case of the F-750 can be wiped clean with a cloth. 

[bookmark: _Toc411419123]

[bookmark: _Toc487711489]Firmware Update Procedure
The firmware of the F-750 is updated by connecting the instrument to a computer using a USB cable and running the Firmware Update tool. The firmware update tool includes step-by-stepdetails instructions for updating the firmware.

This firmware update tool is available online at https://felixinstruments.com/support/F-750/software/
http://www.felixinstruments.com/Software/F-750/FirmwareUpdateTool/index.htmThe firmware update software will give two starting options: Deploy Bootloader, which helps if the firmware has been erased from the unit, and Prompt to copy languages data file to SD card after update, which you should select if you have not yet loaded the languages pack onto your device. Loading the language pack will require a one-time prolonged start-up on the F-750 after the firmware update.

For questions concerning firmware updates, please contact support@felixinstruments.com.
Tip: If you experience any issues with the firmware updating process, “Bootloader AssistDeploy Bootloader”  mode can be accessed selected. by pressing and holding the ‘down’ arrow while turning the device on. Follow the instructions displayed on screen, and continue the firmware updating process as usual.


[bookmark: _Toc487711490]Supporting Science
[bookmark: _Toc386044785][bookmark: _Toc386054674][bookmark: _Toc386119885][bookmark: _Toc411419125][bookmark: _Toc487711491]Fish Fat and Moisture Content
Downey, G. (1996). Non-invasive and non-destructive percutaneous analysis of farmed salmon flesh by near infra-red spectroscopy. Food Chem. 55:305–311.
· NIR interactance range 700-1100 nm
· 6 sites on dorsal and ventral side of each fish (measurement through skin and scales).
· Total of 294 spectra from all different sites.
· Reference chemical values of fat and moisture were determined from excised flesh from the different NIR measurement sites.
· Fat range: 2.3–23.0%
· Moisture range: 57.9–74.7%.
· Spectral measurements on the dorsal surface gave lowest prediction errors (bias corrected) for fat 2.0% and moisture 1.45%.
Lee, M. H., Cavinato, A. G., Mayes, D. M., and Rasco, B. A.(1992). Noninvasive short-wavelength near-infrared spectroscopic method to estimate the crude lipid content in the muscle of intact rainbow trout, J. Agric. Food Chem. 40:2178–2181.
· NIR interactance range 700-1050 nm
· 52 frozen and thawed rainbow trout, Oncorhyncus mykiss (measurement through skin).
· Weight range: 66.5–883 grams
· Local fat range: 2.0–13%
· Prediction error results for fat: 0.7 to 2.3%; correlation coefficients ranged from 0.73 to 0.90 and varied with measurement locations on the fish body.
Wold, J. P. and Isaksoon, T. (1997), Non-Destructive Determination of Fat and Moisture in Whole Atlantic Salmon by Near-Infrared Diffuse Spectroscopy. Journal of Food Science, 62: 734–736.
· NIR interactance range 800-1100 nm (2 nm increments/steps)
· Intact whole farmed Atlantic salmon
· Determine crude fat and moisture
· The method could be used for classification of salmon into groups: 
· Very low fat (less than 8%)
· Low fat (8–12%)
· Medium fat (12–16%)
· High fat (16–20%)
· Very high fat (greater than 20%)

[bookmark: _Toc386044786][bookmark: _Toc386054675][bookmark: _Toc386119886][bookmark: _Toc411419126][bookmark: _Toc487711492]Wine Grape Anthocyanin Content
Cozzolino, D., Parker, M., Dambergs, R. G., Herderich, M. and Gishen, M. (2006), Chemometrics and visible-near infrared spectroscopic monitoring of red wine fermentation in a pilot scale. Biotechnol. Bioeng., 95: 1101–1107.
· NIR interactance range 400 -700 nm
· Began sampling on Day 0 of grape fermentation
· Samples taken after Day 0 showed a marked increase in anthocyanin absorption around 540 nm
· Demonstrates extraction of these phenolic pigments from grape skins into the wine during fermentation.

[bookmark: _Toc386044787][bookmark: _Toc386054676][bookmark: _Toc386119887][bookmark: _Toc411419127][bookmark: _Toc487711493]Mango Model Optimal Wavelengths
Subedi, P., Walsh, K., Owens, G. (2007) Prediction of mango eating quality at harvest using short-wave near infrared spectrometry. Postharvest Biology and Technology, 43: 326–334.
· Optimal wavelength range for DM modeling provides the lowest RMSE.
· Start wavelength range of 700-880 nm and end range of 920-1100 nm. 
· Optimal wavelength range for TSS modeling:
·  Start wavelength range of 740-850 nm and end range of 950-1100 nm. 
· Optimal wavelength range for Hunter b (skin color) modeling:
· Start wavelength range of 760–870 nm and end range of 1000-1100 nm. 
· Optimal wavelength range for maturity score modeling:
· Start wavelength range of 700-850 nm and end range of 1000-1100 nm. 
· The optimal wavelength region was similar for the TSS, DM and Hunter b models, and different to that for the maturity score model.

[bookmark: _Toc386054677][bookmark: _Toc386119888][bookmark: _Toc411419128][bookmark: _Toc487711494][bookmark: _Toc386044788]Kiwifruit
McGlone, V.A. (1998). Firmness, dry-matter and soluble-solids assessment of postharvest kiwifruit by NIR spectroscopy. Postharvest biology and technology (0925-5214), 13 (2), 131.
· NIR interactance range for Dry Matter and TSS 800-1100 nm.
· Known important carbohydrate bands at 880, 900–930 and 970 nm.
· Strong water band at 958 nm.

[bookmark: _Toc386054678][bookmark: _Toc386119889][bookmark: _Toc411419129][bookmark: _Toc487711495]Apple Dry Matter
McGlone, A., Jordan, R., Seelye, R., Clark, C. (2003). Dry-matter – a better predictor of the post-storage soluble solids in apples? Postharvest biology and technology, 28: 431–435. 
· NIR interactance range for apple dry matter: 800-1000 nm.

[bookmark: _Toc386054679][bookmark: _Toc386119890][bookmark: _Toc411419130][bookmark: _Toc487711496]Instrument Precision Optimization
Greensill, C., Walsh, K. (2000) Optimization of Instrumentation Precision and Wavelength Resolution for the Performance of NIR Calibrations of Sucrose in a Water-Cellulose Matrix. Appl. Spectrosc. 54: 426-430.
· NIR interactance range sucrose in water 700-1050 nm

[bookmark: _Toc411419131][bookmark: _Toc487711497]Publications
Cozzolino, D., Parker, M., Dambergs, R. G., Herderich, M. and Gishen, M. (2006), Chemometrics and visible-near infrared spectroscopic monitoring of red wine fermentation in a pilot scale. Biotechnol. Bioeng., 95: 1101–1107.
Downey, G. (1996). Non-invasive and non-destructive percutanous analysis of farmed salmon flesh by near infra-red spectroscopy. Food Chem. 55:305–311.
Greensill, C., Walsh, K. (2000) Optimization of Instrumentation Precision and Wavelength Resolution for the Performance of NIR Calibrations of Sucrose in a Water-Cellulose Matrix. Appl. Spectrosc. 54: 426-430.
Lee, M. H., Cavinato, A. G., Mayes, D. M., and Rasco, B. A. (1992). Noninvasive short-wavelength near-infrared spectroscopic method to estimate the crude lipid content in the muscle of intact rainbow trout, J. Agric. Food Chem. 40:2178–2181.
McGlone, V.A. (1998). Firmness, dry-matter and soluble-solids assessment of postharvest kiwifruit by NIR spectroscopy. Postharvest biology and technology (0925-5214), 13 (2), 131.
McGlone, A., Jordan, R., Seelye, R., Clark, C. (2003). Dry-matter – a better predictor of the post-storage soluble solids in apples? Postharvest biology and technology, 28: 431–435. 
Savitzky, A., Golay, M. (1964) Smoothing and Differentiation of Data by Simplified Least Squares Procedures. Analytical Chemistry, 36(8) 1627–1639.
Sjostrom, M., Wold, S. (1983) A multivariate calibration problem in analytical chemistry solved by partial least-square models in latent variables. Analytica Chimica Acta, (150) 61-70. 
Subedi, P. (2007) Prediction of mango eating quality at harvest using short-wave near infrared spectrometry. Postharvest biology and technology, 43 (3), 326.
Subedi, P., Walsh, K. (2011) Assessment of sugar and starch in intact banana and mango fruit by SWNIR spectroscopy. Postharvest Biology and Technology
Subedi, P., Walsh, K. (2009) Technologies for assessing fruit quantity and quality: maturity, pigmentation, dry matter content, firmness. Mango Encylopaedia, 2(10): 1-39.
Subedi, P., Walsh, K., Hopkins, D. (2012) Assessment of titratable acidity in fruit using short wave near infrared spectroscopy. Part A: establishing a detection limit based on model solutions. Near Infrared Spectrosc., (20) 449-457.
Subedi, P., Walsh, K., Hopkins, D. (2012) Assessment of titratable acidity in fruit using short wave near infrared spectroscopy. Part B: intact fruit studies. Near Infrared Spectrosc., (20) 459-463. 
Subedi, P., Walsh, K., Owens, G. (2007) Prediction of mango eating quality at harvest using short-wave near infrared spectrometry. Postharvest Biology and Technology, 43: 326–334.
Subedi, P., Walsh, K., Purdy, P. (2010) Determination of Optimum Maturity Stages of Mangoes Using Fruit Spectral Signatures, China Int Mango Conf 1-12. 
Walsh, K., Guthrie, J., Burney, J. (2000) Aust. J Application of commercially available, low-cost, miniaturized NIR spectrometers to the assessment of the sugar content of intact fruit. Plant Physiol, 27: 1175-1186.
Walsh, K., Long, R., Middelton, S. (2007) Use of near infra-red spectroscopy in evaluation of source-sink manipulation to increase the soluble sugar content of stonefruit. Journal of Horticultural Science & Biotechnology, (82:2) 316–322.
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[bookmark: _Toc411419132][bookmark: _Toc487711498]F-750 Vocabulary Definitions
Aroma: Comes from volatiles given off by the fruit as they are detected by olfactory receptors when fruit is chewed and swallowed. 
Dry Matter (DM): The ratio of the water content to the dry weight of the fruit. Dry matter is a function of the solids and water the fruit has accumulated while growing on the plant, and is used as an indicator of both taste and texture.
Explained Variance: Share of total variance which is accounted for by the model. For example, an explained variance of 90% implies that the model accounts for 90% of variance in the data.
Flavor: is a combination of taste and aroma
Horizontal Dilution of Precision (HDoP): The HDoP represents an estimate of how much error is introduced to GPS readings by the relative position of the satellites to the user. HDoP is measured on a scale from 1 to 20, with one being the best, and therefore most accurate, and 20 being the worst. An HDoP of 1 to 5 is recommended if GPS readings are going to be taken in the field. 
Interactance Spectroscopy: A mode of NIR spectroscopy where the light is directed into the specimen, interacts with the sample, and is remitted from another location on the specimen which is not receiving light itself. This method is ideal for providing information on the internal composition of the sample (see figure in 

Theory of Operation
Theory of Operation section page 6).
Model Builder File: The type of file used by the F-750 Model Builder Software which includes the Training Set, Reference Values and ranges of spectra to build the model used by the device.
Model Linearity: ‘Goodness of fit’ for the selected number of principle components.
NIPALS (Non-linear Iterative Partial Least Squares): Iterative computer implementation of PLS. PLS is a method used by the F-750 to generate a mathematical model of regression coefficients. PLS1 predicts a single trait with a single regression vector. PLS2 can be used to predict multiple traits with a single regression vector. The F-750 will do PLS1 multiple times to predict multiple traits.
Prefix: This is a label placed on each measurement along with the lot and sample number that may help with organizing data.
Prediction Error: Reference values versus predicted values for each specimen. Cross validation uses ‘leave one out’ grouping by specimen number to simulate an independent data set.
Reference Value: The known concentrations or value of constituent (i.e. trait, quality, or property of interest). This could be the use of a refractometer for total soluble sugar or a scale to determine dry matter content.
Regression Coefficients: Mathematical significance of each pixel, selected in spectra selection, which is used to make predictions. Regression coefficients are a series of weighted values generated by PLS. When these are applied to a scan of an unknown sample, a prediction of concentration is made. These values are the core of the mathematical model. PLS takes multiple scans and combines it with Reference Values to generate a regression vector specific to a single property (such as dry matter). By taking the dot product of the regression vector and a scan of an unknown sample, a concentration can be determined. These are stored in a single row wise vector, there is 1 element in the vector for every pixel used in the regression. 
Root Mean Squared Error (RMSE): Average or percent uncertainty (error) of any individual measurement. For example, a dry matter model with a RMSE of 0.0123 has an error of 1.23%DM or a 1.23% prediction error. An acceptable amount of error is determined by the type of property being predicted and the user application.  It also depends on the uncertainty of the reference method. RMSE is treated as expected error with first standard deviation or 68% of measurements. 
Root Mean Squared Error Calibration (RMSEC): Measurement of goodness of fit between data and calibration model (training set). This is essentially the calibration for training set error prediction. 
Root Mean Squared Error Cross Validation (RMSECV): The error of cross validation of training set prediction. One specimen is taken out, the model rebuilt and that specimen is predicted using the model.  
Root Mean Squared Error Prediction (RMSEP):  A measure of true prediction, measured on real fruit and compared to reference values of an independent data set.
Savitzky–Golay Coefficients: A mathematical tool used to smooth spectra and to generate first or second derivatives. This is useful as it removes noise and the derivative removes baseline offset error. Refer to Savitzky and Golay (1964) for more information. 
Scores Plot: Displays how close each spectra is to the principle components used to create the model. Distinct groups of points indicate “like” specimen, such as when viewing two different temperatures.
SSC: Soluble sugar content
Taste: The amount of sugars and acids in the fruit, as they are detected by taste buds on the tongue. 
Training Set: The set of all of scans that will be used for the PLS regression.
X population: All of the spectra stored in a row rise matrix.
Y population: The Reference Values determined by a reference method stored in a single column vector.


[bookmark: _Toc487711499]Technical Support

If you have a question about the F-750, first look in the F-750 Instruction Manual. There is also online support available for the F-750 at http://felixinstruments.com/support.  If you cannot find the answer, you can contact a Technical Support Representative located in your country. Felix Instruments is committed to provide customers with high quality, timely technical support. Technical support representatives are to answer your technical questions by phone or by e-mail at support@felixinstruments.com. 

Felix Instruments’ contact information: 

Felix Instruments
1554 NE 3rd Ave
Camas, WA 98607 USA

Phone: 800-767-0119 (U.S. and Canada)
360-833-8835
Fax: 360-833-1914

Website: http://www.felixinstruments.com
E-mail: support@felixinstruments.com



[bookmark: _Toc320116032][bookmark: _Toc373304037][bookmark: _Toc411419134][bookmark: _Toc487711500]Customer Service

Customer Service Representatives answer questions about specifications and pricing, and sell all of the Felix Instruments products. Customers sometimes find that they need Felix Instruments to upgrade, recalibrate or repair their system. I. In order for Felix Instruments to offer these services, the customer must first contact us and obtain a Return Merchandise Authorization (RMA) number. Please contact a customer service representative for specific instructions when returning a product. You can e-mail support at support@felixinstruments.com




[bookmark: _Toc411419135][bookmark: _Toc487711501]Frequently Asked Questions
Check our online FAQ for updates at www.felixinstruments.com/support/F-750

1. What can the F-50 Produce Quality Meter measure?
The F-750 Produce Quality Meter is typically used to measure the concentration of dry matter, total soluble solids, chlorophyll, titratable acids, etc. in fruits and other produce. However, the F-750 can be used to measure any substance with a distinct correlation to light in the 285-1200 nm range. This includes everything from steel quality to the liquid content of fish or dry matter in cheese.

2. How do I recharge the batteries of the F-750?
To recharge the batteries, peel off the rubber bumper from the F-750. Then twist to remove the battery compartment cap (located on the bottom of the F-750). Next, remove the batteries from the F-750 to place them in the battery charger. Charged batteries should be inserted into the F-750 positive (+) side first.

3. If the instrument locks up can I reset it without removing the batteries?
Yes, press and hold the power button until you hear a beep. This will cause the instrument to reset. If you have held the power button for longer than ten 10 seconds, and the instrument will not restart, you may need to remove, then re-insert the batteries.

4. What do I do if the F-750 SD card becomes corrupted? 
If your F-750 keeps indicating that it is "checking SD card" or is creating 0 byte length files, this is likely an indicator of a corrupt SD card. Remove the SD card and insert it into a computer.
Copy the "Models" folder and .dat files on the SD card to your PC where you can find them later.
Do not have Windows scan and repair the SD card. Rather, use the following SD card manufacturers tool: https://www.sdcard.org/downloads/formatter_4/index.html

Copy the "Models" folder back onto the SD card. The .dat files are your previous data and do not need to be copied back to the SD card. Then re-install the SD card into the F-750 and turn the power on. 
Always wait for the F-750 to completely power off and shut down before removing the SD card.

5. I started a scan and it will not stop taking scans. How do I stop it?
If you want to stop the device from taking consecutive scans during the process, the opportunity to stop the next scan comes after the measurement data screen displays. When the screen displays after the measurement data screen, press any arrow key. If you have the Delay Between Measurements set to 0, you can hold down any arrow key once the measurement data screen displays until it disappears. After the measurement data screen displays and an arrow key is pressed, you will get a display that gives you the option to press the left arrow to abort or the right arrow to continue taking continuous scans. 

6. I am having trouble updating the firmware on my device, what can I do?
If you experience any issues with the firmware updating process, “Bootloader Assist” mode can be accessed by pressing and holding the ‘down’ arrow while turning the device on. Follow the instructions displayed on screen, and continue the firmware updating process as usual.

7. How many specimen should I use to create a model?
As a general rule, we recommend a minimum of 200 specimens to build a model. The upper limit for number of specimen in a model can be detected by monitoring the RMSECV. As the number of samples increases, the RMSECV should decrease until you see diminishing returns. When there is no longer a change in RMSECV by addition of more samples, the upper limit is reached. For a proof of concept model, 20-30 specimen should be sufficient.

8. How do I change the name of a model after I have already saved it to my F750?
The only way you can set the name of the model is when you Save As… to the SD card from Model Builder. If you would like to change the name of a model, you would have to load the model into Model Builder and Save As… with the desired name. 

9. Why is the scale of the  Savitzky–Golay second derivative off by a factor of 2 in intensity?	Comment by Kevin Hsu: Ryan wanted this put in…. Not quite sure if it’s a frequently asked question though	Comment by Miguel Gonzalez: For those experts out there about this matter it might be important. 
The F750 and F-750 Model Builder Software were designed to be compatible with the original NIRvana. As such, the coefficients are identical to unscrambler V8 and below. 

10. What is Model Fit?
The Model Fit Parameter is a numerical indicator of usefulness of the current model. This number is located on the sample scan screen below the model name on the upper right corner of the screen. Numbers larger than 0 indicate that the sample does not fit well into the currently selected model, and thus the predicted variables should be viewed with skepticism. Variable prediction improves the closer this number gets to 0. The Model Fit Parameter is calculated based on the deviation of spectra signal from the training set range. When recording training set measurements, the F-750 internally tracks the high and low signal extremes for each wavelength. Upon taking a sample scan using these training sets, any point at which a sample spectrum deviates from the training set range triggers an addition to the model fit number. This addition is weighted based on the “wavelength influence” regression coefficient multiplied by the degree of deviation from the established range. Thus, a sample scan that fits perfectly within the training set range will yield a model fit number equal to 0, while subsequent deviations will scale according  to the wavelength influence and magnitude of deviation. For further information, refer to the online FAQ to see supplemental training on this subject.

11. Should I be concerned about stray light around my specimen?
Stray light is accounted for by incorporating a reference shutter and 4 scans to average. The F750 uses an on demand shutter with white reference paint with every measurement. The start-up procedure compares shutter open light on to shutter open light off, which should compensate for any stray light issues by using the built-in white reference standard on the F-750.

12. Can I use the F-750 outdoors?
Yes. The shutter inside of the instrument helps correct for any changes in light level. Outdoor use is one of the applications of the device, and no adjustments for outdoor use are necessary.

13. I am having a problem. I have read the manual and the FAQ’s and I still don’t know what to do. What do I do now? 
If you have a question about the F-750, first look in the F-750 Instruction Manual. There is also online support available for the F-750 at http://felixinstruments.com/support.  If you cannot find the answer, you can contact a Technical Support Representative located in your country. Felix Instruments is committed to provide customers with high quality, timely technical support. Technical support representatives are to answer your technical questions by phone or by e-mail at support@felixinstruments.com. 
14. When in Model Builder, an error is thrown “Missing MSVCP110.dll”, what do I do?
download the Visual C++ Redistributable for Visual Studio 2012 Update 4 at:
https://www.microsoft.com/en-us/download/details.aspx?id=30679
When prompted to choose the download you want: Select "VSU_4/vcredist_x86.exe"
Press Next,
Select Uninstall
Repeat the above steps, then select to install.
Once the setup is complete, open Model Builder and try to rebuild your old model again.



[bookmark: _Toc468965854][bookmark: _Toc487711502]Warranty Information

Seller's Warranty and Liability:
 
Felix Instruments- Applied Food Science warrants new equipment of its own manufacturing against defective workmanship and materials for a period of one year from date of sale. The results of ordinary wear and tear, neglect, misuse, accident and excessive deterioration due to corrosion from any cause is not to be considered a defect. 
Felix Instruments’ liability for repairing or replacing defective parts during the warranty period is contingent on examination by a Felix Instruments authorized representative. Felix Instruments liability will not extend beyond repairing or replacing parts from the factory where they were originally manufactured. Repair or alteration by an unauthorized technician voids warranty. 
Material and equipment which is not manufactured by Felix Instruments is to be covered only by the warranty of its manufacturer. Felix Instruments will not be liable to the Buyer for loss, damage, or injury to persons or to property by the use of equipment manufactured by other companies. 


Buyer accepts the terms of warranty through use of this instrument and any accessory equipment. There are no understandings, representations, or warranties of any kind, express, implied, statutory, or otherwise (including, but without limitation, the implied warranties of merchantability and fitness for a particular purpose), not expressly set forth herein.


All instrument repairs or replacement covered under warranty require a Returned Material Authorization (RMA) number. Please contact Felix Instruments technical support department at support@felixinstruments.com to obtain an RMA number before shipping instrument to CID Bio-Science, Inc. 

Buyer is responsible for shipping charges to Felix Instruments headquarters:

1554 NE 3rd Ave.
Camas, WA 98607
USA


Felix Instruments is responsible for return shipping charges on repairs and/or replacement covered by warranty.



[bookmark: _Toc487711503][bookmark: _Toc411419137]Appendix I: Mango Model Building Standard Operating Procedure (SOP)
The following procedure outlines the process of creating a model on the F-750 device for dry matter and TSS (brix) with mangos.  This SOP is also available at https://felixinstruments.com/support/F-750/. This SOP outlines the process for building a model with room temperature fruit only. The Standard Operating Procedure for including multiple temperatures can be found in the following section. 
[bookmark: _Hlk487720692][bookmark: _Hlk487721001][bookmark: _GoBack]I. Getting prepared for model building
[bookmark: _Hlk487720559]Equipment needed:
· Fruit
· Permanent Marker(s)
1. Select specimen of fruit with a wide range of maturity to be used in training set creation and label with a specimen number. (Note: if both sides of the fruit are to be scanned label each side as their own sample #, i.e.; mango 1 will be samples 1 and 2, mango 2 will be samples 3 and 4 and so on.)

II. Preparing the F-750
Equipment needed:
· F-750
1. Turn on the F-750 and navigate to the Setup Menu > Training Sets > Create New Training Set.
2. Enter a name to use for the new training set using the up and down arrows to select characters and press the right arrow to enter (pressing the right arrow twice moves to the next menu.)
3. Enter the number of specimens that will be used to build the model (minimum of 10 specimens.) Press the right arrow again to create the training set file. Be aware this step can take a few minutes, and very large training sets (5000+) can take up to an hour to process.
4. After the training set has been created, press right to enter the Browse Specimen Data menu. Navigate to the mid temperature option for making your model with room temperature fruit. 

Now we will begin scanning each specimen. 


III. Scanning Fruit
Equipment needed:
· Permanent Marker(s)
· F-750
1. Place the first specimen on the fruit adaptor of the F-750 and use a permanent marker to mark the area to be scanned. [image: ]
2. On the F-750 with Specimen 1 highlighted on the list, press the right arrow to collect the training spectra. The instrument will indicate “Processing”. Do not press the scan button to gather training set spectra.
3. After each specimen has been scanned, you will see a date and time included in the specimen file name. (Note: Specimens can be re-recorded if a mistake is made or the wrong specimen/temperature is selected.)
4. Repeat for all specimens at the Mid Temperature.
You are now finished creating your training set. The same specimens used for training set creation will now be used to collect reference values for building a predictive model. 



IV. Collecting Dry Matter Reference Data
Equipment Needed:
· Paring knife
· Cutting board
· Circular corer
· Microbalance
· Food dehydrator(s)
1. Remove the fruit skin from the area which was marked and scanned with the F-750 with a sharp knife being careful to both fully remove the skin ONLY, but also to remove as little meat as possibletaking care to remove as little tissue under the skin as possible. 
[image: ]
2. Push the 26mm circular corer to the seed of the mango in the prepared area.
 [image: ]
3. Remove the corer and slice the mango close to the seed removing the core of sampled mango. [image: ]
4. Trim the mango core on the seed side, so the total height of the cylinder is 2cm. [image: ]
5. Weigh the sample in a microbalance immediately and record the weight to the nearest .001 grams. The expected wet mass should be around 10-12 g.
6. Dry the samples in a dehydrator for 48 hours set at 63-65°C.
7. After 40 hours, re-weigh a few of the samples and record the values. Replace the samples back into the dehydrator.  
8. Re-check the same samples a couple of hours later and see if they have changed in weight, if they have not you can assume they are fully dehydrated.
9. Measure all samples one at a time in a microbalance and record the values.
10. Divide the final (dry) weight from the initial (wet) weight for each sample to determine the Dry Matter. 

IV. Collecting Brix/SSC Reference Data
Equipment Needed:
· Paring knife
· Cutting board
· Circular corer
· Digital Refractometer
· Garlic Press/cheese cloth
1. Ensure fruit and refractometer have equilibrated to the same temperature. 
2. Remove the fruit skin from the area which was marked and scanned with the F-750 with a sharp knife being careful to fully remove the skin ONLY, taking care to remove as little tissue under the skin as possible. being careful to both fully remove the skin, but also to remove as little meat as possible.
3. Push the 26mm circular corer to the seed of the mango in the prepared area.
4. Remove the corer and slice the mango close to the seed removing the core of sampled mango.
5. Trim the mango core on the seed side, so the total height of the cylinder is 2cm. 
6. Load the sample core into the garlic press or cheese cloth
7. Holding the press over the refractometer, apply pressure until several drops of juices have covered the quartz optical sensor of the refractometer.
 [image: ]
8. Press the scan button and record the value
9. Press the scan button again to ensure the refractometer has given a stable reading
10. Wipe and dry the refractometer
11. Repeat process with the next specimen.
12. It is useful to occasionally check the zero of the refractometer with DI water.
Appendix II: Mango Model Building Standard Operating Procedure (SOP) with Multiple Temperatures

I. Getting prepared for model building with fruit at multiple temperatures
Equipment needed:
· Environmental chamber at temperature
· Fruit
· Permanent Marker(s)
1. Select specimen of fruit with a wide range of maturity to be used in training set creation and label with a specimen number. (Note: if both sides of the fruit are to be scanned label each side as their own sample #, i.e.; mango 1 will be samples 1 and 2, mango 2 will be samples 3 and 4 and so on.)
a. If amending a previous model, the number of specimen used should be approximately 20% of the number of specimen used to build the original model. For example, if the original model built was with 60 specimen, use 12 specimen to build this training set.
2. Determine the three temperatures to be used for the training set (Minimum, Mid, and Maximum.) It is best to choose a range of temperatures encompassing the range which the measurements will be taken in the field, for example, 10°C, 20°C, 30°C.
3. Place the fruit in a temperature controlled environmental chamber (a temperature controlled room will work.)
4. After the fruit has been given enough time to come to the pre-determined temperature (generally about one hour.) It is now time to begin taking measurements for the training set.

II. Preparing the F-750
Equipment needed:
· F-750
5. Turn on the F-750 and navigate to the Setup Menu > Training Sets > Create New Training Set.
6. Enter a name to use for the new training set using the up and down arrows to select characters and press the right arrow to enter (pressing the right arrow twice moves to the next menu.)
7. Enter the number of specimens that will be used to build the model (minimum of 10 specimens.) Press the right arrow again to create the training set file. Be aware this step can take a few minutes, and very large training sets (5000+) can take up to an hour to process.
8. After the training set has been created, press right to enter the Browse Specimen Data menu. Navigate to the mid temperature option for making your model with room temperature fruit. 

Now we will begin scanning each specimen. 
III. Scanning Fruit
Equipment needed:
· Permanent Marker(s)
· F-750
5. Place the first specimen on the fruit adaptor of the F-750 and use a permanent marker to mark the area to be scanned. [image: ]
6. On the F-750 with Specimen 1 highlighted on the list, press the right arrow to collect the training spectra. The instrument will indicate “Processing”. Do not press the scan button to gather training set spectra.
7. After each specimen has been scanned, you will see a date and time included in the specimen file name. (Note: Specimens can be re-recorded if a mistake is made or the wrong specimen/temperature is selected.)
8. Repeat for all specimens at the Minimum Temperature.
9. After all specimens have been recorded at the Minimum Temperature, place the specimens back in the temperature controlled area to bring the fruit to your next selected temperature: Mid temperature.
10. After specimens have reached the desire Mid temperature, the next set of temperature data is ready to be collected.
11. If you have turned off the F-750 while waiting for the specimens to reach their next temperature, navigate to the Setup Menu > Training Sets > Modify Existing Training Set and select the training set you created previously.
12. Within your training set file go to Browse Specimen Data and navigate to the Mid Temperature folder. Place the first specimen on the fruit adaptor and align with pervious san location markings, and with Specimen 1 highlighted on the list press the right arrow to collect the training spectra.
13. Repeat for all specimens at Mid temperature. (Note: You will be using the same specimens for all three temperature sets so the specimen must be scanned in the same order and at the same location as was done for the Minimum Temperature.)
14. Repeat the previous steps for the Maximum Temperature when the specimens are at the selected temperature.

You are now finished creating your training set. The same specimens used for training set creation will now be used to collect reference values for building a predictive model. 
Steps IV and V regarding reference value collection can be found in Appendix I. 


[bookmark: _Toc487711504]F-750 Production Test Check Sheet

Date:  ___________________
Technician Initials:  ___________________
Serial #:  ___________________
Spectrometer #:  ___________________
Firmware Version:  ___________________

Spectrometer Pixel Coefficients
	C0:
	C1:
C2:
C3:
Spectrometer DAC Offset:
Reference Voltage:
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1554 NE 3rd Ave, Camas, WA 98607, USA
Phone: (360) 833-8835 Fax: (360) 833-1914 e-mail: sales@felixinstruments.com Web: www.felixinstruments.com		
PRODUCT REGISTRATION CARD
Please complete and return this form to Felix Instruments within 30 days to validate your Warranty on Parts & Labor.
			
Registration Information:		
Your Name:____________________________________ Title:__________________
Company/University:___________________________________________________
Address:_____________________________________________________________	
City:____________________________ State:__________ Zip:__________________
Country:__________________________Email_______________________________
Phone:______________________________ Fax:____________________________
Felix Instruments Serial Number(s):__________________________________________________	
Purchase Date:_____________________Purchase Price:_____________________	
------------------------------------------------------------------------------------------------------------------
FOLD ON DOTTED LINE
				
Your opinions will help improve our service. Please answer the following questions.

1. What was the basis of your product selection?
□ Representative Recommendation				□ Price
□ Product Features					□ Product Design
□ Technical Specifications					□ Brand Name
□ Warranty 						□ Service
□ Other _________________________________________

2. What other competing brands did you consider? __________________________

3. Where did you first learn of this product?
□ Advertisement in ________________________________			□ Representative
□ Friend/Colleague					□ Exhibit
□ Other _________________________________________

4. Who selected this product?
□ I did						□ Research Group
□ University Department					□ Purchasing
□ Other _________________________________________

5. Comments/Suggestions: 
______________________________________________________________________
______________________________________________________________________
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sales@felixinstruments.com 
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[image: ]1554 NE 3rd Ave, Camas, WA 98607, USA                  117
Phone: (360) 833-8835
sales@felixinstruments.com
www.felixinstruments.com
image67.png




image68.png




image69.png




image70.png




image1.png




image71.png




image72.png




image73.png
\Q;\

INSTRUMENTS

APPLIED FOOD SCIENCE




image2.jpeg
F

o
&
g
3
3
i
£
&





image3.png




image4.png




image5.png
MicrousB  SD Card Lens Hand Strap
Connection





image6.jpeg
-
1
&
.
&
\





image7.jpeg
-
1
&
.
&
\





image8.png
Select Model

R
-

Browse Measurements

‘Spectrometer Pixel Coefficients
‘Spectrometer Stabilty Criteria
Spectrometer ADC gain
‘Spectrometer zero & span

‘Spectrometer quantum efficiency
Spectrometer voltage correction

Lamp Stability Criteria
Lamp Automatic Gain
Lamp Off Delay

Lamp On Delay

Lamp Timeout

- Lamp Age

Setup Instrument

L——

Shutter Open Delay
Shutter Close Delay

!

Lamp Shutter Closed Integration Time
Lamp Shutter Open Integration Time
*Menu boxes filled with green

should only be accessed by

Temperature Correction (Enabled)
direction of a technician. * N C;iiorate Temperature





image9.png
Decrement if Measurement Deleted
Increment Lot # Every X Samples

Current Sample #
Current Lot #
Increment/Decrement Logic
Append As Measurement Suffix

Enter New Prefix
Select Recently Used Prefix

Scans to Average
Integration Time

Lamp State

Shutter State

Number of Repetitions

Delay between Repetitions
Measure Spectrometer Noise
Collect Spectra

Create Folder
Select Folder

Create New Training Set
Modify Existing Training Set

GPS State (Enabled)
View Status

L Setup Instrument

*Menu boxes filled with green
should only be accessed by
direction ofa technician.

**Conditional options are
enclosed with parentheses.

Lot & Sample #
Measurement Prefix
Archive Measurements
Date & Time

Training Sets

GPS Receiver

Keypad Sounds
Diagnostics

Advanced Setup

Disabled
Quiet
Default
Loud

Auto Integration Time

Temperature Correction
Reference Voltage
Power Savings
Watchdog

Factory Reset

Debug Logging

Manual Test

View Temperature

Spectrometer

Lamp

= -





image10.png




image11.png
Type

Measurements
Measurements & Details
Raw Spectra

Interpolated Spectra





image12.png
™ ® FlashAir’

Wireless LAN model  veraoz
DRIVE: F

B Network settings

2 Wireless LAN startup mode

FlashAir drive

+R,Initisize the card/chango
settings

> 2 Heb

Sting

(FW Ver FASCAWGAWZ0001)




image13.png
You can use the internet

=

You can also connect to FlashAir




image14.png
0-10% yellow

10 - 30% yellow

30 - 50% yellow

50 - 70% yellow 70 - 90% yellow

W

90 - 100% yellow

amia @ @EE





image15.jpeg




image16.jpeg
p———
CID_DM_TSS

@





image17.jpeg




image140.jpeg




image18.png




image19.png




image20.png
¢ F750 Model Builder v1.0371 =8

Training Set Reference Values | Model Specira | Device View ® Tanstom (S mport

[Rap— Specraame 5om s80m a1 29tom 210m st0mm s





image21.png
Known Vaues [vode

Mid Temp
i Temp
vid Temp

i temp

in Temp

o o o
o o o 4





image22.png
Training Set| Reference Values |Model Spectra

% Dry Matter ce Value #2





image23.png
J51650m 655 5rm 694.57m 733 5nm772.5nm 511,57 850.5nm 259,50 928.5nm 967501 006.5nm1045.5nm1 084 5t 123,51 162,501 191

Training Set | Reference Values = Model Spectra Device View | Model Performance Analysis / Find Correlation

Range #1 Range #2

> Spectra for sugar 50ml | 729 - 975 nm




image24.png
@ sugarlab SOl - F750 Model Builder 10370

X >

,,/\f

Model Spectra | Device View





image25.png
Training Set | Reference Values

Reference Value

brix o
Graph
Explained Variance v

Model Spectra | Device View Model Performance Analysis

Variance Exphined

8312

100

80
60
40
20
0

7

5 6 7 8
Frinciple Components

B

0

kil

12

1 User Selection
CV Variance Explained
— Variance Explained





image26.png
‘Training Set | Reference Values |Mode| Spectra | Device View| Model Performance Analysis ‘

Reference Value : : Z 5 User Slcion
brix é T RMSECV
Graph 5

‘{Roo( Mean Square Error'; ¥ E 7

T2 3 & 5 6 7 8 § W01 1270
Principle Components




image27.png
Training Set | Reference Values | Model Spectra | Device View Model Performance Analysis

1 5 User Selection
Reference Value — Ny Predicton R®
- 8 — Cross Validation R*
brix o
6
Graph 3 4
h S T z
Model Linearity o 2

12 3 4 5 6 7 & § 1 11 12
Principle Components




image28.png
Training Set | Reference Values |Model Spectra | Device View Model Performance Analysis

Reference Value 2424 — Perfect Prediction
+Full Training Set Prediction
brix v + Cross Validation Predicton
2165 + Reference Value
2
Graph 3 1906
- - =
Prediction Error O g
¢ A £ 1647
# of Principle Components
e P 1388
8 v

n

2
1026 1349 1672 1994 2317
Reference Values




image29.png
Training Set | Reference Values | Model Spectra | Device View Model Performance Analysis

Reference Value 117603 — Regression Coefcients
brix o s 77
S
Graph H
. - £ amm
Regression Coefficients | v El
5 3819
# of Principle Components ]
8 v £ 341083

[ Draw Principle Components

Wavelength




image30.png
Training Set | Reference Values | Model Spectra | Device View| Model Performance Analysis

Reference Value 0.0010 . Specimen Scores for Principle
Components 12042
brix v 10,0006
Graph
orepl . 0.0002
Scores Plot o
-0.0003 -
Princple Components Drawn (X,Y)
1 J b . 0.0007
0.0012

00024 00015 -0.0006 00003  0.0013




image31.png




image32.png
845%

676%+

507%+

338% 4

| worpposg sty

169% 1

Wavelength





image290.png




image300.png
845%

676%+

507%+

338% 4

| worpposg sty

169% 1

Wavelength





image33.png
Training Set | Reference Values | Model Spectra | Device View| Model Performance Analysis

— Viavelength Influence

Reference Value 1056%
brix v 845%
Graph
. - 634%
Wavelength Influence | v
423%
212%

Wavelength




image34.png




image35.png
— Wavelength Influence

Wavelength

6.15%
492% 1
369% 1
246% 1
124%

aauan|u| vonoipal abiieny




image340.png
— Wavelength Influence

Wavelength

6.15%
492% 1
369% 1
246% 1
124%

aauan|u| vonoipal abiieny




image36.png
el Spectra | Device View Model Performance Analysis

0.0010

0.0006 |- -

peimen #1239 (139)
7e-05x 14.590-04
-

0.0002 T .

000031 LI

-0.0007F

0.0032,
Foozs X 50006 50003 To013




image37.png
Training Set |Reference Values | Model Specira | Device View | Model Performance ® Transform ¥ Import

Exclude  Specimen # Spectra Name 285nm 288nm 291 nm
O 235 31 0 0 0
0O |236 33 0 0 0
O 237 35 0 0 0
0O |238 37 0 0 0
» - 239 39 0 0 0
0O |240 41 0 0 0
O |241 43 [ [ [





image38.png
Training Set | Reference Values |Model Spectra | Device View Model Performance Analysis

Reference Value 2024 | #260(r81) =23.06 . — perct reicion
s #260(81)=22.57°8 NGtk

brix v - alon,

#260(r81) =19.70 £

g
Graph = 1906
- - E
|Prediction Error 1o I

4 s
# o
of Principle Components e g ¢
8 v

129t
026 1349 1672 1994 2317

Reference Values




image39.png
Training Set | Reference Values

Reference Value

brix o
Graph

:Scores Plot o
Princple Components Drawn (XY)

Model Spectra | Device View Model Performance Analysis

0.0006

0.0004

0.0001

0.0002

0.0004

200 do7

0.0007

0.0003

0.0002

0.0006

. Specimen Scares forPrinciple

Components 1 and 2




image40.png




image41.png
- DATA (D)
= Vacid (\CIDSER
v <

File name:

‘Save as type: [Model Buider Files 1.2 and above (*-modelBuider)

« bide Foldes N
Reference Value o

60. —
Brix

fance Explainod





image42.png
Prediction 1

Current lot and
sample number

Date and time of

collection

Record name

n Value Name 123456 of 999999

12.34

Lot/Sample: 1/3

|, Filename: RecordName

Location: 45.588239, -122.381955

Measurement number

Name of the model

Fit of the current
prediction

GPS location

il




image43.png




image44.png
Button to add an Button to remove on-
on-screen element screen elements

aining Set Reference Values Mogkl Spectra Devi

Drop-down box

featuring all the on- /

pregctonz s
screen elements pregctontit o001
available for Predctonzst o021

customization Messurementiumber 123456 of 399998

Modeiame Gxampleiodel
FiaName RecordName.
CrestedDateTime 72pass o8 Simulated F-750 display
SampleNumberhndiotiumber 173 screen. View changes made
Sampleumber

Window for Lothumber under Device View here

customizing the Predctontlothversge before implementation
PregctiontiotStandardOevation
selected element

Description box, pull up to see
descriptors for selections in
Model Builder

rediciont —





image45.png
el B oshw EL




image46.png




image47.png




image48.png




image49.png




image50.png




image52.PNG
Training Set Reference Values Model Spectra Device View

PredictionValueVariable -/ Add Remove

PredictionValueVariable

Variable Prediction1
Format D2

Prefix

Suffix

Location 8, 20
Alignment Left

Type Large
Hidden False





image53.PNG
Training Set Reference Values Model Spectra Device View

PredictionValueLabel -/ Add Remove

Name PredictionValueLabel

Prediction Value Name

Location 8,8
Alignment Left
Type Small

Hidden False





image54.png
-/ Add Remove

DM
Variable Prediction1
Format D2
Prefix
Suffix
Location 8, 20
Alignment Left
Type Large
Hidden False





image55.png
PredictionValueVariable

Name
Variable
Format
Prefix
Suffix

*| Location
Alignment
Type
Hidden

Add Remove

PredictionValueVariable
Prediction1

D2

Brix

9,34
Left
Medium
False

Pre n Value Name 123456 of 999999
Brix12.34 Examp
0.0010

Lot/Sample: 1/3

Created: 1/2/3456 7: 0 AM
Filename: RecordName

Location: 45.588239, -122.381955




image56.PNG
2 3 . 45 123456 of 9%9999 &)
12.34

Created: 1/2/3456 7:08:00 AM
Filename: RecordName
Location: 45.588239, -122.381955





image57.png
One must designate a
location for the text on
the screen. You can drag
and drop the text box on
the simulated device
screen.





image58.png
Brix B Add Remove 23 4 5 123456 of 999999
Name Brix )
Variable Prediction2 12 34
Format D2 -

i 1 1/2/34 :08: /
S o
Suffix Location: 45 588239, -122.381955

* Location 91
Alignment Left
Type Large
Hidden False





image59.png
& F750 Model Builder v1.3.0.177

X )

Setup Build

616:50m | 655.5nm  694.5nm  733.50m  772.5nm 811.50m  850.50m  889.5nm  928.5nm  967.5nm  1006.5nm  1045.5nm  1084.5nm  1123.5nm  1162.5nm 1191

Training Set Reference Values Model Spectra Device View = Templates
Ratiolndex_10 -/ Add Remove 123456 of 999999
Examp
Ratiolndex_10 0.0010
Type CustomRatiolndex
Formula ((A[700] - A[700]) - 0.2f * (A[700]- A[5501)) * (A[700] / A[700])
Format D2 C_reated: 1/2/3456 7:08:00 AM
5 Filename: RecordName
Prefix Location: 45.588239, -122.381955
Suffix
* Location 0,0
Alignment Left
Type Medium
Hidden False

Name





image60.png
Rule_10 - Add Remove

Name Rule_10
Variable Prediction1
Condition LessThan
9.0
Action Beep
ActionDetails
BeepDuration 500

NumberOfBeeps 1





image61.png
Type

Measurements
Measurements & Details
Raw Spectra D

erpolated Spectra Absorbance

First Derivative





image62.png
38250m 4215nm 57750m 77250m 81150 a505nm a595nm 925.50m 975nm  10065nm  10455nm  10845nm  11235nm  dl625nm

Training Set Model Spectra

Exclude ~ Specimen # Spectra Name ‘ 285 nm ‘ 288 nm 291nm 294 nm 297 nm 309 nm

1 0 0 0 0





image63.png
Training Set| Reference Values ‘Model Spectra | Device ViewlModeI Pe

Specimen # brix Dry matter
1 20.80
2 19.7
3 14.50
4 2040
5 2170
6 175
7 1530
s Er—





image64.png




image65.png




image66.jpeg




image74.png
\\Q‘;\

FEL

INSTRUMENTS




image51.png
' Customization of On-Screen Ele.
Name
Tt
Variable
Format
Prefix
Sufix
Location
Alignment
Type
Hidden




